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Arabic Word Update

Welcome to Arabic Microsoft Word 6.0.    This README file is available in the English language only. This 
section describes some of the known limitations of the Arabic edition of Word for Windows 6.0.    It is important 
that you become aware of the following issues before you start your work. All other sections of the Readme file 
pertain directly to US Microsoft Word for Windows 6.0. Please refer to the User's Guide for further information.

Arabic Word 6.0 and US Word 6.0 documents are compatible except for Hi and Med justification.    Arabic 
text must be justified as Low in order to be opened by US Word 6.0.    A Hi or Med Justification will cause a General 
Protection Fault.

Certain features, such as MS Graph and Equation Editor will have limited or no support for bi-directional 
text. 

Word Art 2.0 supports only one language per object.    If you need to create a mixed language object, you 
should create an object for each language.

Setup will not install Arabic Word for Windows on Arabic Enabled Windows.    Microsoft Windows for 
Workgroups Arabic Edition version 3.11 and Microsoft Windows with Arabic language support version 3.1, which 
provides dual language interfaces Arabic and English, are the supported environments for Arabic Word. Microsoft 
Windows for Workgroups Arabic Edition is the recommended environment for optimum performance.    Enabled 
Arabic Windows (the first release of Arabic Microsoft Windows) is not a supported environment for Word for 
Windows Arabic Edition version 6.0.

Text pasted as a picture can not be edited.
Certain lists such as the ones found in Insert.Index and Tables and in Format.Labels and Envelopes will be 

displayed either in Arabic or English, depending on the language of the first setup done.    These lists will not change 
even if you change the interface language.

Certain large sizes of fonts might cause problems in Word.
When using the Decotype Naskh Extension font, certain combination of letters might cause the characters 

to flip around each other.    If this occurs, use the Decotype Naskh Swashes.
When formatting text (underline, bold, italic) with Decotype Naskh fonts, certain special effects might be 

noticed such as the redundant display of characters.    This is a display problem only and will not be visible in print.
The functions SUM(LEFT) and SUM(RIGHT) are based on a Left to Right direction table.    In Right to 

Left direction tables, use SUM(LEFT) to find the sum of the right cells and SUM(RIGHT) to find the sum of the left 
cells.

If you are specifying the user interface language from the command line, you must use /LTR (for English) 
or /RTL (for Arabic).    The User must use /LTR (for English) or /RTL (for Arabic).    The User's Guide Supplement 
incorrectly states /L (for English) and /B (for Arabic).

User interface language switching is not allowed in the following cases:
Multiple instances of Arabic Word 6.0 on the same machine.
Multiple users running workstation configuration.

When using Custom Setup to put help files in directories other than default, you must not split two 
language versions of the same help file into separate directories.    For example, if you choose to install the Word 
PSS Help in both English and Arabic, you must specify the same directory for both.

When spell checking an Arabic word with numbers, you need to click on the word in the "Not in 
Dictionary" edit box in order to activate the suggest button.

When viewing multiple pages of your document in Page Layout or Print Preview, the flow of pages from 
Right-to-Left or Left-to-Right follows the Outline direction option in the Tools.Options.Arabic tab.

Arabic Gutter margins do not flip the right and left margins as stated in the User's Guide Supplement.
When working in Outline view with Facing Columns, heading styles are applied to both columns. 

Changing the style of the first column using the tab key will change the style of the second column.
In Facing Columns, Visual Movement and Visual Selection are not supported.
If one column in a facing column document extends beyond one page, you will encounter some problems 

with screen repainting. Inserting a page break in the other column will solve this problem.
If you use the Spike command with the English interface and switch to the Arabic interface before inserting 

your Spike, you will need to use the English word Spike in order to access the Autotext entry.    You will also need to 
manually delete the entry when you are finished with it or you will have conflicts next time you use the feature with 
the English interface.

When editing text in Facing Columns in multiple page Print Preview, you may run into some repainting 



problems if one column extends to a second page and the other does not.    When typing text in the shorter column, 
the text may appear on the next page as well.    This is a repainting problem only and will not show once the text 
wraps to the next page, or when printed.

If you are using the Arabic comma as a separator for the short date format, you may run into some display 
problems with the samples in the Insert Date and Time dialog.        You can fix this by choosing System from the 
Word control menu and changing the date format separator to something other than the Arabic comma.

Arabic Month names that consist of two words will not sort correctly. You can change the format of the 
month name to numerical format, sort and then change back to month name format. 

The Find and Replace feature now includes the ability to search for formatting or neutral characters in a 
specific language when you are working in a mixed text document.    For example, to search for Arabic spaces only, 
in the Find dialog, type a space, then choose the Format button, select Language and choose Arabic.

When running Wizards, hotkeys are limited to the language of interface.
Arabic Word 6.0 and US Word 6.0 share the same WINWORD6.INI.    Therefore spell checkers, grammar 

checkers, most recently used files and other settings are shared by both applications.    To disable this feature, you 
must specify a different path for each application from the Tools.Options.File Location tab.

The AutoCorrect Smart Quotes feature can be activatednly if the Latin keyboard was used to insert the 
quotes.

When using the Add Routing Slip command under Windows for Workgroups - Arabic Edition, mixed text 
will not be correctly displayed if the Orientation setting in MSMAIL.INI file is set to 0 (zero).    To ensure proper 
display, set the Orientation setting to 1 (one).    Earlier versions of Arabic Windows will not support    this feature.

Saving documents as Arabic Windows Write 3.1, will display, at the beginning of the document, characters 
that are not part of the actual saved text.

Windows WIN.INI file should have the following fonts listed in the following order:
Simplified Arabic Backslanted Italic
Simplified Arabic Backslanted Bold Italic
Traditional Arabic Backslanted Italic
Traditional Arabic Backslanted Bold Italic

It is recommended to use ANORMAL.DOT created by Word for Windows 6.0 - Arabic Edition as the 
default template.    ANORMAL.DOT from Word for Windows 2.0 with Arabic Language Support has several 
limitations.
Thank you for your support.
The Arabic Word Team



Installing the Share Utility

When you install Word, Setup installs the Share utility. Many features depend on Share, including document 
sharing features, and therefore Share is required to run Word. Depending on your computer configuration, Setup 
adds a line in AUTOEXEC.BAT or CONFIG.SYS that runs SHARE.EXE or a line in SYSTEM.INI that loads 
VSHARE.386.

When you restart your computer, the Share utility should load and Word should run properly. If you are not able to 
start Word, or if errors occur when you try to open or save files, you may need to manually adjust your Share 
installation.

For instructions, see the section below that corresponds to your computer. If you make any changes to the startup 
files, restart your computer so the changes take effect. Note: The instructions assume that SHARE.EXE is in your 
DOS directory on drive C; if SHARE.EXE is in a different directory, substitute the appropriate path.

80286 CPU

With any MS-DOS version except 4.01, open CONFIG.SYS and remove any line that loads Share. Make sure the 
following line appears in AUTOEXEC.BAT:

C:\DOS\SHARE.EXE /L:500 /F:5100

With MS-DOS version 4.01, open AUTOEXEC.BAT and remove any line that loads Share. Make sure the 
following line appears in CONFIG.SYS:

install=c:\dos\share.exe /L:500 /F:5100

80386 (or higher) CPU

If you are running Windows in Enhanced Mode, open CONFIG.SYS and AUTOEXEC.BAT and remove any line 
that loads Share. Make sure the following line appears in the [386Enh] section of SYSTEM.INI (located in your 
Windows directory):

device=vshare.386

If you are running Windows in Standard Mode, open CONFIG.SYS and remove any line that loads Share. Make 
sure the following line appears in AUTOEXEC.BAT:

C:\DOS\SHARE.EXE /L:500 /F:5100



Notes on Running the Word Demonstrations

Please note the following points about running the Word demonstrations, available by choosing Quick Preview or 
Examples And Demos from the Help menu, or by choosing the Demo button in a Help example screen.

If you are running Word on a 386 computer, it can take up to five minutes to start the Word demonstrations. 
This is normal for a 386 computer. While the demonstrations are loading, a message will display. When a 
demonstration has been loaded, the message will be removed from the screen.

If you get an "Out of Memory" message while running the Word demonstrations, you will need to free up 
additional memory before continuing. Close any open Windows applications before attempting to run the 
demonstrations again.

Do not attempt to run the Word demonstrations under Windows NT. If you try to run the demonstrations 
under Windows NT, you run the risk of your Windows session hanging, even though it may appear as if the 
demonstrations are running correctly.

Do not attempt to run the Word demonstrations with an application that has the Always On Top setting 
selected. If you run a demonstration with this setting selected, the application will interfere with the demonstration.



Supplied Online Business Forms

Word version 6.0 includes templates for an invoice, a purchase order, and a weekly time sheet. These templates are 
designed to be filled out online. For complete information about forms in Word, see Chapter 14, "Forms," in the 
Microsoft Word User's Guide.

Invoice and Purchase order (INVOICE.DOT and PURCHORD.DOT)      These two forms contain placeholders 
for your company name, slogan, street address, telephone number, and fax number, as well as contact name and 
telephone number. The form fields in the last column will automatically calculate a subtotal and total.

Weekly time sheet (WEEKTIME.DOT)      This form contains placeholders for your company name, slogan, 
street address, telephone number, and fax number. The form fields will automatically calculate totals, both for 
rows and for the Regular Hours, Overtime Hours, and Total Hours columns.

To modify one of the supplied form templates for your own use, choose Open from the File menu. In the List Files 
Of Type box, select Document Templates. In the File Name box, type or select the name of the form template you 
want to modify (INVOICE.DOT, PURCHORD.DOT, or WEEKTIME.DOT), and then choose the OK button. 
From the Tools menu, choose Unprotect Document (this step removes protection from the form template so that 
you can modify it). Replace the placeholders with the actual name, address, and telephone number of your 
company and make whatever other changes you want. When you have finished modifying the form template, 
choose Protect Document from the Tools menu to protect the form so that users can fill in only the blanks when 
they complete the form online. From the File menu, choose Save.



Using the Legal Pleading Wizard

The Legal Pleading Wizard (or Pleading Wizard) creates a legal pleading paper. When you use this wizard, you can 
specify the name of the court, attorney, and client; set page layout options such as the font, line spacing, and 
margins; and insert line numbers. For details on using wizards, see Chapter 5, "Wizards, Templates, and Business 
Letters," in Microsoft Word Quick Results.



Disk Space Requirements

Some of the estimates for the amount of disk space you need to install Word have changed. If you choose the 
Laptop (Minimum) installation, you need at least 5 MB available on your hard drive. The Typical installation 
requires 18 MB. The Complete installation requires 25 MB. For the Workstation installation, you need at least 4 
MB, but you may need more depending on how your system administrator configured the administrator's 
installation. If you want to perform an administrator's installation on a network file server or a shared directory, 
you need 25 MB of available space on the file server or the shared directory; the shared components of Word also 
require an additional 6 MB.



Screen Display and Video Drivers

If you notice display problems such as blank portions of the screen, italic characters overwriting one another, or 
lines of text highlighted with colored bars, you may need to update the video driver for your system. To get the 
latest drivers, contact the manufacturer of your computer system or display card.

Dell S3 video driver

With Dell S3 video driver version 1.3a or earlier, you may encounter GP Faults working with page, column, or 
section breaks in page layout view or print preview, Equation Editor, or the Quick Preview. Version 1.32 fixes 
these problems and is now available. For information on obtaining the driver upgrade, contact Dell customer 
support. Phone numbers are listed in your Dell computer manual.

ATI display driver

Older versions of the ATI display driver may produce screen "garbage" when you close a dialog box, select text, or 
type in the first line of a document. If you have an ATI card with the Mach 32 chipset, you can use ATI driver 
version 2.1 to resolve these problems. If you have an ATI card with the Mach 8 chipset, use ATI driver version 2.2 
or later. For information on obtaining the driver upgrade, contact your computer manufacturer, or ATI directly, 
using the phone numbers listed in your computer or video card manual.



Canceling Printing

To cancel printing

If background printing is off, do one of the following:
In Windows, press ESC.
On the Macintosh, press COMMAND+PERIOD, or press ESC.

If background printing is on, do one of the following:
Double-click the printer icon on the status bar.
From the File menu, choose Print, and then choose the Stop Print button.



Changing a Heading Used in a Cross-reference

To change a heading that is used in a cross-reference, make sure that bookmarks are visible before you change the 
heading. Word adds a bookmark to a heading when you create a cross-reference. Displaying bookmarks makes it 
easier to ensure that the changes you make are included in that bookmark. If the changes are not included in that 
bookmark, cross-references won't update correctly.

To display bookmarks, choose Options from the Tools menu, and then select the View tab. Under Show, select the 
Bookmarks check box, and then choose the OK button. When the Bookmarks check box is selected, Word encloses 
each bookmark in brackets. If you add text to a heading, make sure the new text is inside those brackets. To update 
the cross-reference when you finish editing the heading, select the cross-reference or the entire document and press 
F9.



Running the Examples and Demos from a Network Installation

If you install Word from a network administrator's installation (see Appendix B in the Microsoft Word User's 
Guide) and choose the Custom, Minimum, or Workstation options in Setup, you may run the Examples and Demos 
from the network server rather than installing it on your computer. If you do so, you must use a logical drive letter 
(for example, N:) to specify the network server before you run Setup from the network server. If you use a UNC 
pathname (of the form \\server\share) to connect to the network server, Setup will not be able to properly connect 
you to the Examples and Demos.



Additional Word Startup Switches

When you start Word from the MS-DOS® command prompt, you can supply a "switch" to perform another task as 
Word starts. In addition to the switches listed in Chapter 1 of Microsoft Word Quick Results, you can use the 
following switches:

To start Word Type

And load a Word Link 
Library (.WLL)

win c:
\winword\winword /lWLL 
filename

Without displaying 
Tips of the Day

win c:\winword\winword /w



Modifying How Word Compiles an Index

You can modify the sort order and placement of index cross-references by changing your WINWORD6.INI file. 
By default, Word sorts index entries word by word and places index cross-references at the end of an index entry. If 
you want, you can have Word sort index entries letter by letter, and you can have Word place index cross-
references where you add them.

Changing sort order in an index from word by word to letter by letter

To change the sort order in your index from word by word to letter by letter, you add the following to your 
WINWORD6.INI file under [Index]:

; Sort letter by letter instead of word by word
SortLetterByLetter=1

To change the index sort order back to word by word, remove this line from your WINWORD6.INI file.

Changing the placement of index cross-references

To change the placement of index cross-references to the order in which you add them to the index entry, you add 
the following to your WINWORD6.INI file under [Index]:

; Use WinWord 2.0 behavior of placing cross-references where they're added
WW2CrossReference=1



Grouping Symbols at the Beginning of an Index

If you include symbols (such as ©, @, and so forth) in an index, and you want to group them at the beginning of 
the index, use the following procedure.

To group symbols at the beginning of an index

1. Select a symbol that you have inserted in the document.

2. Press ALT+SHIFT+X (Windows) or OPTION+SHIFT+X (Macintosh).

3. In the Main Entry box, immediately following the symbol, type ;#symbol_name (semicolon followed by the 
pound sign, followed by the name of the symbol with no spaces). When typing the symbol name, use lowercase 
letters. For example, if you want the plus sign to appear in a list of symbols, you type ;#plus immediately after 
the symbol, so that +;#plus would appear in the Main Entry box.

4. Choose the Mark button. The dialog box stays open so that you can mark multiple index entries. Do not choose 
the Mark All button because every symbol in the document will be marked the same. You must mark each 
symbol individually.

5. To mark additional symbols, repeat steps 3 and 4.

6. When you finish marking symbols for index entries, choose the Close button in the Mark Index Entry dialog 
box.

When you mark index entries, Word inserts an XE (Index Entry) field in hidden text format in the document. If you 
mark + (the plus sign), for example, you will see {XE "+;#plus"} in your document. For &, you would see {XE 
"&;#ampersand"} in your document. When you compile the index, Word sorts the symbols by the spelling of the 
symbol name. In this example, the symbol for ampersand would appear before the plus sign. Each symbol is 
followed by the page number where the symbol was marked. All symbols are grouped under # (the pound sign) at 
the beginning of your index. You can either delete the pound sign or replace it with a heading, such as Symbols. 



Using Fields to Create a Table of Contents or Other Table

In addition to using heading styles and styles that you define, you can also create a table of contents or other table 
by using Table of Contents Entry (TC) fields. You first mark with a field the text or item you want included in the 
table and then you compile the table.

To mark entries for a table of contents using TC fields

1. Select the text you want to be included in a table of contents.

2. Press ALT+SHIFT+O to display the Mark Table Of Contents Entry dialog box.

The selected text will appear in the Entry box. If you want, you can apply formatting, such as making the text 
bold or italic. To display a shortcut menu, position the insertion point in the Entry box and click the right mouse 
button.

3. In the Table Identifier box, type or select c to indicate a table of contents entry. (If you use a letter other than c, 
you must use the Table Of Figures tab to compile your table.)

4. In the Level box, type or select a number for the level of the entry. The level number is similar to the heading 
level when you use styles to mark headings for a table of contents. A level 3 entry, for example, is subordinate 
to a level 2 entry.

5. Choose the Mark button. The dialog box stays open so that you can mark multiple entries. 

For more information about the TC field, double-click the Help button on the Standard toolbar. Then type TC 
(Table of Contents Entry) field

6. When you finish marking entries, choose the Close button.

To compile a table of contents using TC fields

1. Position the insertion point where you want to create the table of contents.

2. From the Insert menu, choose Index And Tables, and then select the Table Of Contents tab.

3. In the Formats box, select the format you want for the table of contents. If you want to display page numbers in 
the table of contents, select the Show Page Numbers check box.

4. Choose the Options button.

5. Under Build Tables Of Contents From, clear the Styles check box, select the Table Entry Fields check box, and 
then choose the OK button.

6. Choose the OK button to compile the table of contents.

To mark entries for a table of figures or other table using TC fields

1. Select the text you want to be included in a table of figures or other table.

2. Press ALT+SHIFT+O to display the Mark Table Of Contents Entry dialog box.

The selected text will appear in the Entry box. If you want, you can apply formatting, such as making the text 
bold or italic. To display a shortcut menu, position the insertion point in the Entry box and click the right mouse 
button.

3. In the Table Identifier box, type or select a letter to identify entries for a particular table. Except for f, which 
indicates a table of figures entry, and c, which indicates a table of contents entry, you can assign any letter you 
want. Just make sure you keep track of which letters correspond to which tables, because you will use the table 
identifier when you compile the table. 

4. Choose the Mark button. The dialog box stays open so that you can mark multiple entries. 

For more information about the TC field, double-click the Help button on the Standard toolbar. Then type TC 
(Table of Contents Entry) field

5. When you finish marking entries, choose the Close button.

To compile a table of figures or other table using TC fields

1. Position the insertion point where you want to create the table of figures or other table.



2. From the Insert menu, choose Index And Tables, and then select the Table Of Figures tab.

3. In the Formats box, select the format you want for the table. If you want to display page numbers in the table, 
select the Show Page Numbers check box.

4. Choose the Options button.

5. Under Build Tables Of Figures From, clear the Style check box if it is selected, and select the Table Entry Fields 
check box.

6. In the Table Identifier box, type or select the table identifier, and then choose the OK button. The table identifier 
is the letter you used in the Mark Table Of Contents Entry dialog box to indicate a particular kind of table.

7. Choose the OK button to compile the table of figures or other table.



Confirming Changes to NORMAL.DOT

When you add, delete, or change AutoText entries, macros, toolbars, and styles that are stored in the Normal 
document template, Word saves the template without asking you to confirm the changes. If you prefer to confirm 
such changes, choose Options from the Tools menu, and then select the Save tab. Select the Prompt To Save 
NORMAL.DOT check box, and then choose the OK button. Setting this option controls whether Word asks you to 
confirm changes only to NORMAL.DOT. Word always asks if you want to save changes to templates other than 
the Normal document template.



Going to Bookmarks Not in the Main Document Window

When you want to go to a bookmark in an annotation, footnote, or endnote, you must first open the pane 
containing the item you want to go to, and then position the insertion point in that pane before you can use the Go 
To command or the Go To button in the Bookmark dialog box. If you try to go to an annotation, footnote, or 
endnote without following these steps, either the Go To button will not be available or the name of the bookmark 
will not appear. You cannot go to a bookmark in a header or footer.



Customizing Sample Text for the Style Gallery Command

You can customize the sample formatted text Word displays in the Style Gallery dialog box (Format menu) by 
editing the following AutoText (glossary) entries for a particular template:

Edit this entry
To change the sample for this
Style Gallery option

Gallery Example Example

Gallery Style Samples Style Samples

First, use the Open command on the File menu to open the template you want to modify. Then edit the appropriate 
AutoText entry and save the updated entry in the template.



Opening and Saving Word Documents Within Lotus Notes

If Lotus Notes version 2.1 or version 3.0 is installed on your computer, the Word Setup program modifies your 
Notes configuration to allow Notes to open Word documents.    To open a Word document in Notes, choose Import 
from the File menu, select Microsoft Word from the list of import file types, and then select the Word document 
you want to import. To save Notes text as a Word document, choose Export from the File menu, select Microsoft 
Word RTF from the list of export file types, and save the file. All versions of Word can open RTF files directly.



Support for Vendor Independent Messaging (VIM) 1.0

Word supports Vendor Independent Messaging (VIM) 1.0, which means that you can use the Send and Add/Edit 
Routing Slip commands (File menu) in Word to send or route Word documents with mail applications such as 
Lotus cc:Mail that support VIM 1.0.

VIM is automatically installed by cc:Mail version 2.0 (or greater) and Notes version 3.0 (or greater).    Lotus 
cc:Mail 1.11 users may get VIM support files from Lotus. 

The DOS PATH command in the AUTOEXEC.BAT file must include the directory in which the mail application's 
VIM support files are stored. Otherwise, the Word Setup program will not install Word support for VIM. If Word 
support has already been installed, it will not function correctly if the VIM directory is not included in the DOS 
PATH command.

The Word support file for VIM 1.0 is called MAPIVIM.DLL and is stored in the System subdirectory of the 
Windows program directory.



If Help Displays "This resource cannot be displayed" Message

If Word or WordBasic Help displays the message "This resource cannot be displayed," the Help support files 
SHARERES.DLL and WORDRES.DLL may not be properly installed. 

SHARERES.DLL must be installed in the System subdirectory of the Windows program directory.
WORDRES.DLL must be installed in one of the directories specified in the PATH= line of the MS 

SHARERES section in the WIN.INI file. (WIN.INI is located in the Windows program directory.)
There should be only one copy of SHARERES.DLL and WORDRES.DLL on your computer. Outdated 

versions should be deleted.

If these files are installed on your computer but in the wrong directories, you need to move them to the appropriate 
directories. (You can use the File Manager to search your computer's hard disk to determine where these files are 
stored.) You can also delete these files and use the Word Setup program to reinstall them. 



Upgrading Additional Language Versions of the Proofing Tools

If you purchased additional language versions of proofing tools (such as dictionaries) for use with Word version 2.x 
for Windows, you need to upgrade these proofing tools in order to use them with Word version 6.0 for Windows. 
To obtain new versions of the proofing tools, contact Microsoft customer service or the vendor from whom you 
originally purchased the proofing tools.



Using HP DeskJet Printers

Background printing and the HP DeskJet 550C and 1200C

Background printing is not available from Word 6.0 when using version 3.1 of the HPPC5.DRV and 
DESKJETC.DRV printer drivers due to an incompatibility between Word for Windows 6.0 and the HP drivers. HP 
is investigating a solution to resolve this incompatibility.

Printing envelopes on the HP DeskJet 500 and 550C

For best results when printing envelopes on these printers, HP recommends that you feed the envelopes as 
described in the HP manual that came with the printer. Make sure to turn off the Clockwise Rotation option in 
Word. To turn off this option, choose Envelopes And Labels from the Tools menu, select Feed, and then clear the 
Clockwise Rotation check box.



Special Notes on Using Word Version 6.0 with Other Software

Word for Windows & Bookshelf

If you install Word 6.0 (without Bookshelf) over a Word 2.0 & Bookshelf installation, the Bookshelf button 
appears on the Word For Windows 2.0 toolbar, not the new Standard toolbar. In addition, the image on the 
Bookshelf button becomes a piggy bank picture. You can use the Customize command (Tools menu) to move the 
button to another toolbar or to change the button image.

OS/2 2.1

If you are installing Word on a computer with OS/2 version 2.1 and Word Setup asks you to reboot your computer, 
answer No to avoid a system failure. Instead, manually run _MSRSTRT.EXE in your Windows directory.

Windows NT
For best results using Word 6.0 on Windows NT version 3.10 (or Windows NT Advanced Server), please 

install Windows NT Service Pack 1 or higher. To verify the exact version of Windows NT, run WINVER.EXE from 
the Windows NT command prompt. The second line of the WINVER dialog box should read "Version 3.10 (build 
528: CSD002)" or higher. Windows NT Service Pack 1 is available on CompuServe and via anonymous FTP on the 
Internet, as well as from Microsoft. For additional information on obtaining Windows NT Service Pack 1, consult 
Your Guide to Service and Support for Microsoft Windows NT, included with Windows NT.

Word does not support selecting different paper trays in the current version of Windows NT. This means 
that you cannot print envelopes consistently with Word running on Windows NT. Use the Windows NT Print 
Manager to select a different form on which to print.

The current version of Windows NT does not support printing embedded EPS graphics.
The current version of Windows NT does not support printing to a file.

Central Point Desktop

If you are installing Word on a computer with Central Point Desktop (included with Central Point's PC Tools for 
Windows) and Word Setup asks you to reboot your computer, answer No. Instead, manually run _MSRSTRT.EXE 
in your Windows directory.

Windows Help Compiler

Versions of the Windows Help Compiler (HC.EXE and HCP.EXE) earlier than version 504 are incompatible with 
Word 6.0 RTF files. Upgrade to the latest version of the Windows Help Compiler for proper compilation of help 
files.



Accessing ODBC Databases Through a Network

If you use an ODBC driver to access a database stored on a network server, you must first connect the server to a 
literal drive letter.



Storing Temporary Files on a RAM Drive

Word 6.0 uses temporary files more extensively than Word 2.0. As a result, if your TEMP environment variable is 
set to your RAM drive, your RAM drive can fill up much more quickly than in Word 2.0. With Word 6.0, you 
should use a directory on a hard disk instead of your RAM drive as the TEMP directory.



Custom and Network Installations

This topic contains tables of Word components and their default locations for standalone, network, and workstation 
installations.

Files installed by Setup on a standalone workstation

Files installed by Setup on a network server

Files installed by Workstation Setup on workstations with individual copies of Windows

Files installed by Workstation Setup on workstations that run Windows from the network

For more information on network installations and for instructions on creating custom installations for workstation 
users, see Appendix B, "Installing and Using Word on a Network," in the Microsoft Word User's Guide. For 
instructions on running Setup to install Word on a workstation, see Chapter 1, "Installing and Starting Word," in 
Microsoft Word Quick Results.

Setting up Word on a network server

To set up Word on a network server, you must run the Setup program using the command line setup /a from a 
workstation connected to that server. 

If you run Setup from the server itself, the Setup program will display a message indicating that it could not detect 
a network server and path for the Word program directory and asking for the correct server and path. If you 
continue setting up, all workstations set up from that network server will get local copies of shared components. If 
this is not what you want, exit the Setup program and then run it from a workstation connected to the network 
server, as recommended.



Files installed by Setup on a standalone workstation

When you install Word for Windows on a standalone workstation, Setup copies files to the hard disk as follows for 
Typical, Complete, or Minimum installation. For information about the files installed by Workstation Setup, see 
Files installed by Workstation Setup on workstations with individual copies of Windows or Files installed by 
Workstation Setup on workstations that run Windows from the network.

WINWORD
Files installed Typical Complete Minimum

Executable files

WINWORD.EXE Yes Yes Yes

MACRODE.EXE Yes Yes No

Registration file

WINWORD6.REG Yes Yes Yes

Interface strings

WWINTL.DLL Yes Yes Yes

Help

WDREADME.HLP Yes Yes Yes

WINWORD.HLP Yes Yes No

WRDBASIC.HLP No Yes No

WORDHELP.DLL Yes Yes Yes

WORDPSS.HLP Yes Yes No

WORDRES.DLL Yes Yes No

WPHELP.HLP (Setup queries 
user for Yes or No.)

Yes/No Yes/No Yes/No

Hyphenation

HYPH.DLL Yes Yes No

HY_EN.LEX Yes Yes No

Grammar checker

GRAM.DLL Yes Yes No

GR_AM.LEX or GR_BR.LEX Yes Yes No

Converter to export to MS-
DOS Text with Layout

TXTWLYT.CNV Yes Yes No

Screen fonts 

DIALOG.FON Yes Yes Yes

WINWORD\CLIPART
Files installed Typical Complete Minimum

Sample Windows metafiles

*.WMF Yes Yes No

WINWORD\LETTERS
Files installed Typical Complete Minimum

Prewritten business letters

*.DOT No Yes No

WINWORD\MACROS



Files installed Typical Complete Minimum

Templates with sample macros

*.DOT No Yes No

WINWORD\SETUP
Files installed Typical Complete Minimum

Setup files

SETUP.EXE Yes Yes No

_MSSETUP.EXE Yes Yes No

MSSETUP.DLL Yes Yes No

WORD_BB.DLL Yes Yes No

WINWORD6.INF Yes Yes No

SETUP.STF Yes Yes Yes

MSCPYDIS.DLL Yes Yes No

ACMSETUP.HLP Yes Yes No

ODBCINST.DLL Yes Yes No

WWSETUP.TTF Yes Yes No

WINWORD\STARTUP
No files

WINWORD\TEMPLATE
Files installed Typical Complete Minimum

Wizards, sample document 
templates, and sample forms

*.WIZ, *.WZS Yes Yes No

*.DOT Yes Yes No

*.DOT Yes Yes No

WINWORD\WORDCBT
Files installed Typical Complete Minimum

Files for online examples, 
demonstrations, and the Quick 
Preview

*.* Yes Yes No

PREVIEW.LES Yes Yes No

*.DOC Yes Yes No

WINDOWS
Files installed Typical Complete Minimum

Font mapping file

MSFNTMAP.INI Yes Yes Yes

Converter options file 

MSTXTCNV.INI Yes Yes Yes

TrueType options file

TTEMBED.INI Yes Yes Yes

WINDOWS\SYSTEM



Files installed Typical Complete Minimum

Dynamic-link libraries

MAPIVIM.DLL (if cc:Mail is 
installed)

Yes Yes Yes

SDM.DLL Yes Yes Yes

CTL3DV2.DLL Yes Yes Yes

SHARERES.DLL Yes Yes No

WORDCBT.DLL Yes Yes No

PCDLIB.DLL No Yes No

TTEMBED.DLL Yes Yes Yes

Object linking and embedding 
(OLE) files

COMPOBJ.DLL Yes Yes Yes

OLE2.DLL Yes Yes Yes

OLE2.REG Yes Yes Yes

OLE2CONV.DLL Yes Yes Yes

OLE2DISP.DLL Yes Yes Yes

OLE2NLS.DLL Yes Yes Yes

OLE2PROX.DLL Yes Yes Yes

STORAGE.DLL Yes Yes Yes

Open database connectivity 
(ODBC) files

ODBC.DLL No Yes No

ODBCADM.EXE No Yes No

ODBCINST.DLL No Yes No

ODBCINST.HLP No Yes No

XBS110.DLL No Yes No

SIMBA.DLL No Yes No

SIMADMIN.DLL No Yes No

MSJETDSP.DLL No Yes No

DRVDBASE.HLP No Yes No

DRVFOX.HLP No Yes No

PDX110.DLL No Yes No

DRVPARDX.HLP No Yes No

RED110.DLL No Yes No

DRVACCSS.HLP No Yes No

WordArt TrueType font files

*.TTF Yes Yes No

Linedraw TrueType font file

LINEDRAW.TTF Yes Yes No

Equation Editor TrueType font 
file

MTEXTRA.TTF No Yes No



Toolbar button editor and the 
Microsoft toolbar

COMMTB.DLL Yes Yes Yes

MSTOOLBR.DLL Yes Yes Yes

WINDOWS\MSAPPS\EQUATION
Files installed Typical Complete Minimum

Microsoft Equation Editor files  
EQNEDIT.EXE No Yes No

EQNEDIT.HLP No Yes No

EQNEDIT2.REG No Yes No

WINDOWS\MSAPPS\GRPHFLT
Files installed Typical Complete Minimum

Graphics filters

CGMIMP.FLT No Yes No

MS.CGM No Yes No

DRWIMP.FLT No Yes No

MS.DRW No Yes No

DXFIMP.FLT No Yes No

EPSIMP.FLT Yes Yes No

MS.EPS No Yes No

GIFIMP.FLT No Yes No

MS.GIF No Yes No

IFFGIF.DLL No Yes No

IFFPCD.DLL No Yes No

IFFPCX.DLL No Yes No

IFFTIFF.DLL Yes Yes No

MS.TIF No Yes No

PCDIMP.FLT No Yes No

PCXIMP.FLT  No Yes No

MS.PCX No Yes No

PICTIMP.FLT Yes Yes Yes

MS.PCT No Yes No

TIFFIMP.FLT Yes Yes No

WPGEXP.FLT Yes Yes No

WPGIMP.FLT Yes Yes No

MS.WPG No Yes No

WINDOWS\MSAPPS\MSGRAPH
Files installed Typical Complete Minimum

Microsoft Graph files

GRAPH.EXE No Yes No

MSGRAPH.HLP No Yes No

MSGRAPH3.REG No Yes No



WINDOWS\MSAPPS\MSINFO
Files installed Typical Complete Minimum

System information

MSINFO.EXE Yes Yes Yes

WINDOWS\MSAPPS\PROOF
Files installed Typical Complete Minimum

Proofing tools files 

MSSPEL2.DLL Yes Yes Yes

MSSP2_EN.LEX Yes Yes Yes

MSTHES.DLL Yes Yes No

MSTH_AM.LEX or 
MSTH_BR.LEX

Yes Yes No

WINDOWS\MSAPPS\TEXTCONV
Files installed Typical Complete Minimum

Text converters

MSWORD6.CNV No Yes No

RFTDCA.CNV No Yes No

RTF_DCA.TXT No Yes No

WORDDOS.CNV Yes Yes No

RTF_PCW.TXT Yes Yes No

WORDMAC.CONV Yes Yes No

RTF_MW5.TXT Yes Yes No

WORDWIN2.CNV Yes Yes Yes

WPFT5.CNV Yes Yes No

WPFT5.EQU Yes Yes No

RTF_WP5.TXT Yes Yes No

WRITWIN.CNV Yes Yes Yes

XLBIFF.CNV Yes Yes No

WINDOWS\MSAPPS\WORDART
Files installed Typical Complete Minimum

Microsoft WordArt files

WORDART2.EXE Yes Yes No

WORDART2.HLP Yes Yes No

WORDART2.REG Yes Yes No

In addition, if Setup detects that Lotus Notes is installed, _MSIMP.DLL is copied to the Lotus Notes program 
directory (regardless of whether the installation is Typical, Complete, or Minimum).



Files installed by Setup on a network server

When you install Word on a network server, Setup creates the following directory structure.

\WINWORD

\CLIPART
\LETTERS
\MACROS
\SHARED
\SYSTEM
\TEMPLATE
\WORDCBT

Installing Word on a network server does not modify the WINDOWS or WINDOWS\SYSTEM directory on the 
server's hard disk, unless Setup runs from a workstation that is using a shared version of Windows. From a 
workstation that is not using a shared version of Windows, Setup copies all files that are installed in the 
WINDOWS and WINDOWS\SYSTEM directories during a Complete setup to the WINWORD\SYSTEM 
directory on the server; from a workstation that is using a shared version of Windows, Setup updates the 
WINDOWS and WINDOWS\SYSTEM directories on the server as appropriate (note that you must have write 
access to the server's WINDOWS and WINDOWS\SYSTEM directories). 

Setup copies the ADMIN.INF file to the WINWORD directory on the network server and renames the file 
WINWORD6.INF.

Also note that Setup does not create a SETUP directory within the program directory, as it does for a Complete 
installation. All the setup files are placed in the WINWORD program directory.

Setup stores a copy of all shared applications, converters, and graphics filters in the WINWORD\SHARED 
directory on the network server; this is the source for setting up local versions of these files on standalone 
workstations. In addition, Setup creates the following directory structure for shared components (or updates shared 
components if they already exist).

\MSAPPS

\EQUATION
\GRPHFLT
\MSGRAPH
\MSINFO
\PROOF
\TEXTCONV
\WORDART

Note that the shared components stored in the MSAPPS directory can be updated by subsequent application 
installations on the network server; files in the WINWORD\SHARED directory cannot. 

For complete lists of the files copied by Setup into the directories described above, see the corresponding 
directories in Files installed by Setup on a standalone workstation.



Files installed by Workstation Setup on workstations with individual copies of Windows

Workstation Setup for Word for Windows installs three types of files: system files, application files, and private 
initialization files. Note that Setup must have write access to the following directories on the target workstation to 
set them up as shown:

WINWORD
No files

WINWORD\SETUP

SETUP.STF

WINWORD\STARTUP
No files

WINWORD\TEMPLATE
No files

Like Complete Setup, Workstation Setup copies system files to the workstation's WINDOWS and 
WINDOWS\SYSTEM directories. For a complete listing of the files copied to these directories, see Files installed 
by Setup on a standalone workstation.

If the network server does not specify that Workstation Setup should install "local" or "shared" versions of the tools 
in the server's MSAPPS subdirectories, Setup prompts the user to specify Local or Shared. If the user selects Local, 
Setup installs the MSAPPS files on the user's hard disk as in a standalone workstation installation. If the user 
selects Shared, the files are not copied to the user's hard disk.



Files installed by Workstation Setup on workstations that run Windows from the network

When Setup installs Word for Windows on a workstation that uses a shared copy of Windows, it does not update 
the system files or the application files. Setup does, however, require write access to the following directories on 
the target workstation to set them up as shown:

WINWORD
No files

WINWORD\SETUP

SETUP.STF

WINWORD\STARTUP
No files

WINWORD\TEMPLATE
No files

Before performing workstation installations, the administrator must have write access to the server's system 
directories, and install Word on the server first. This allows Setup to update all system components properly. 
System components include DLLs (such as SDM.DLL and MAPIVIM.DLL) and common components (such as 
Equation Editor and Microsoft Graph).

Ensuring that system components are updated on the network prevents Setup from attempting to install system 
components during subsequent workstation installations (when Setup may not have write access to do so).



Graphics Filters

Overview

Installing Graphics Filters

Information on Specific Filters

Windows and Graphics Limitations

Troubleshooting



Overview of Graphics Filters

This section provides information about limitations and options when importing graphics saved in the following 
graphic file formats into Microsoft Word for Windows documents.

CompuServe GIF (.GIF)

Computer Graphics Metafile (.CGM)

Encapsulated PostScript (.EPS)

Macintosh PICT (.PCT)

Micrografx Designer/Draw (.DRW)

PC Paintbrush (.PCX)

Tagged Image File Format (.TIF)

Windows Bitmaps and Metafiles (.BMP, .WMF)

WordPerfect Graphics (.WPG)

WordPerfect Graphics Export (.WPG)

All graphic import filters have been written to the Aldus Graphic Filter Specification version 1.0 and are intended 
to run under Windows version 3.0 or later.

To enhance display and scrolling speed, a Windows metafile representation of each imported picture becomes a 
part of your document. The size of your file increases considerably with the inclusion of these metafile 
representations. You can choose not to include these metafiles by selecting the Link To File option and clearing the 
Save Picture in Document option in the Picture dialog box (Insert menu).

You should not run converters while multitasking.

Additional Converters 

Additional graphics filters for the following file formats are also available from Microsoft:

AutoCAD DXF (.DXF)
AutoCAD plotter files (ADI)
Corel Draw 3.0 (CDR)
HP Graphics Language (HPGL)
Kodak Photo CD (.PCD)
Lotus 1-2-3 graphics files (PIC)
Truevision Targa (TGA)

To obtain the Supplemental File Conversion disks (one 5.25-inch [1.2 MB] and one 3.5-inch disk [1.44 MB]) free 
of charge, see the "Microsoft Word for Windows Supplemental Offers" coupon included in your Word for 
Windows package. If you cannot locate this coupon, please call the Microsoft Sales Information Center at (800) 
426-9400. Deaf or hard-of-hearing customers can call Microsoft Text Telephone (TT/TDD) services at (800) 892-
5234.

These converters are also available for downloading from the Microsoft Download Service or from the MSWord 
Forum Files Library on CompuServe. For more information on accessing these services, see Using the Microsoft 
Download Service and Using Microsoft Forums on CompuServe.



Installing Graphics Filters
You should use the Word Setup program to install these graphics filters. If you want to add filters after installing 
Word, start Setup and select the Complete/Custom Installation option. Then select the check box for Converters, 
Filters, and Data Access. Choose the Change Option button and select the Graphics Filters check box. (Do not 
clear check boxes corresponding to components you have already installed, or the Setup program will uninstall 
them.) 

If you do not install the filters using the Setup program, you must copy and decompress the filters manually. For 
more information, see Chapter 1, "Installing and Starting Word" in Microsoft Word Quick Results.

In addition, note that each filter must be listed in the Windows WIN.INI file. You can add listings using the 
Advanced Settings dialog box or by adding the listings directly to the WIN.INI file.

To use the Advanced Settings dialog box to add graphics filter entries to WIN.INI

1. From the Tools menu, choose Macro.

2. In the Macros Available In box, select Word Commands.

3. Select ToolsAdvancedSettings from the list of commands.

3. Choose the Run button.

4. In the Categories list in the Advanced Settings dialog box, type or select MS Graphic Import Filters (WIN.INI) 
or MS Graphic Export Filters (WIN.INI).

5. In the Option box, type the name of the filter you want to add.

6. In the Setting box, type the path and filename of the filter.

7. Choose the Set button.

If you want to work with the WIN.INI file directly, use the syntax in the following list for the filter you want to 
install. If necessary, replace the path "C:\WINDOWS\MSAPPS\GRPHFLT" with the appropriate path to the filter.

[MS Graphic Import Filters]

DrawPerfect(.WPG)=C:\WINDOWS\MSAPPS\GRPHFLT\WPGIMP.FLT,WPG

Micrografx Designer/Draw(.DRW)=C:\WINDOWS\MSAPPS\GRPHFLT\DRWIMP.FLT,DRW

CompuServe GIF(.GIF)=C:\WINDOWS\MSAPPS\GRPHFLT\GIFIMP.FLT,GIF

Macintosh PICT Filter(.PCT)=C:\WINDOWS\MSAPPS\GRPHFLT\PICTIMP.FLT,PCT

Computer Graphics Metafile(.CGM)=C:\WINDOWS\MSAPPS\GRPHFLT\CGMIMP.FLT,CGM

Encapsulated PostScript(.EPS)=C:\WINDOWS\MSAPPS\GRPHFLT\EPSIMP.FLT,EPS

Tagged Image Format(.TIF)=C:\WINDOWS\MSAPPS\GRPHFLT\TIFFIMP.FLT,TIF

PC Paintbrush(.PCX)=C:\WINDOWS\MSAPPS\GRPHFLT\PCXIMP.FLT,PCX

[MS Graphic Export Filters]

DrawPerfect(.WPG)=C:\WINDOWS\MSAPPS\GRPHFLT\WPGEXP.FLT,WPG

BitmapMemory

Under the [Microsoft Word] section of the WINWORD6.INI file, you can add the entry BitmapMemory=x, where 
x is the size of the bitmap cache in kilobytes. Word uses a default size of 1024K. Increasing this number increases 
the size of the bitmap cache Word uses for speeding picture redraw. You should not specify a number greater than 
the amount of available free RAM. Setting this number to 0 (zero) may solve problems with certain video drivers, 
but will considerably slow picture redraw.



Troubleshooting
If a filter cannot convert a graphic that you want to insert, you may see a message saying that the file is empty or 
does not contain a graphic, or that the graphics filter could not convert the file. Check the following list of 
procedures and considerations for suggestions about how to correct the problem:

If you have trouble importing a graphic into Word, it may not have been saved properly by the application 
in which you created it. Try reloading the graphic into the original application. If the image does not appear as it did 
when originally created, or if the application cannot read the file, try exporting the file in a different format.

Is the appropriate graphics filter properly installed and correctly listed in the [MS Graphic Import Filters] 
section of WIN.INI?

How much memory is available on your system? Word requires at least as much memory as the size of the 
uncompressed graphic image.

How much TEMP disk space is available? Whenever a graphic is imported into a Word document, the 
document file size permanently increases by approximately the size of the original graphic file. If there is not at least 
this much space available and enough room for Windows to maintain its temporary swap files, you cannot import 
the graphic image.

If the source is a Windows application, try copying the picture to the Clipboard and then pasting the picture 
directly into Word.

If the file format of the graphic is a version not supported by one of the import filters, try opening the 
graphic in the original application and saving it in another format.



Windows and Graphics Limitations
If a graphic that you import is not converted properly, the problem may be due to differences between the original 
graphic format and the way Windows handles graphics.

Text in Windows Object- or Vector-oriented Pictures

Limitations in graphic primitives in Windows pictures prevent display and printing of the following:

Mirrored or backward text
Rotated or vertical text (unless scalable or vector fonts are used)
Double underline and outline

Scaling

Windows may not scale an image as expected. For example, if a bitmap is reduced or viewed at less than 100 
percent size, display information may be lost. This can result in missing thin lines, odd patterns, or grid lines. 
Pieces may appear to be missing. These are artifacts of scaling a bitmap for display on your monitor and usually 
are not present in the higher-resolution printout.

If the image is a object- or vector-oriented picture, text can only be scaled by its point size. Stretching a character 
to make it disproportionately tall or disproportionately wide may result in poor text layout.

Color

Word now uses a fixed 256-color palette if your system is capable of displaying more than 16 colors. Depending 
on the type of image, it will either be mapped to the palette, or dithered using the 16 Windows colors. By doing 
this, Word achieves a more accurate on-screen display while still providing excellent redraw speed. If you have a 
printer and a printer driver that support more than the standard 16 Windows colors, the colors in the picture are 
rendered as appropriately as possible using information contained within the graphic. A 300 dpi laser printer may 
simulate 256 colors by dithering.

The following filters use the color information in the file as indicated:

BMP, CGM, DRW, 
EPS, GIF, PCX, PICT, 
TIFF, WMF, WPG

Use color palette in file



Information on Specific Filters

This topic contains information on importing the following graphic file formats into Microsoft Word for Windows 
documents.

CompuServe GIF (.GIF)

Computer Graphics Metafile (.CGM)

Encapsulated PostScript (.EPS)

Macintosh PICT (.PCT)

Micrografx Designer/Draw (.DRW)

PC Paintbrush (.PCX)

Tagged Image File Format (.TIF)

Windows Bitmaps and Metafiles (.BMP, .WMF)

WordPerfect Graphics (.WPG)

WordPerfect Graphics Export (.WPG)



Tagged Image File Format (.TIF)
The TIFF 5.0 filter supports all image types and compressions described in the TIFF Specification Revision 5.0. 
These types include monochrome, grayscale, palette color, and RGB full color images. This filter does not support 
TIFF Revision 6.0.



CompuServe GIF (.GIF)
The CompuServe GIF filter supports versions GIF87a and GIF89a.



Macintosh PICT (.PCT)
This filter supports both PICT and PICT2 formats



Encapsulated PostScript (.EPS)
This EPS graphics filter EPSIMP.FLT supports the Adobe Systems Encapsulated PostScript Specification versions 
1.0 and 2.0.

An EPS file is a standard PostScript language file with an optional bitmap screen preview included in the format. 
An EPS file is generally included in other documents, such as Word files, as an illustration. The Word for Windows 
6.0 EPS filter supports EPS images with Tagged Image File Format (TIFF) 5.0 or Windows Metafile (WMF) 
embedded display images.

If an EPS file contains an embedded TIFF or WMF display image, a representation of the image is displayed in 
Word for Windows. The quality of the display image depends on the resolution of the TIFF or WMF image 
embedded in the EPS file. Because such display images are intended primarily for positioning aid in page 
composition, resolution is often low.

If an embedded TIFF or WMF display image is not included, or if the image is considered invalid by the converter, 
a graphics bounding box appears instead of a display image.

Printing Documents Containing EPS Graphics

When printing to a PostScript printer, regardless of whether a TIFF or WMF display image is embedded in the EPS 
file, the PostScript commands from the PostScript section of the file are sent to the printer. The on-screen 
resolution of the display image has no effect on the printing quality of the file.

When printing to a non-PostScript printer, if a TIFF or WMF display image is embedded in the EPS file, the TIFF 
or WMF image is printed. As indicated above, such images are normally of low resolution (for example, 128 x 128 
bits). When a document containing an embedded EPS image is sent to a non-PostScript printer, the resolution of 
the printed image is relatively low.

If a document contains an EPS file without an embedded TIFF or WMF display image, or if the image is 
considered invalid by the converter, only the bounding box is printed on a non-PostScript printer.

Word for Windows version 1.x supplied macros to import EPS image files, but these macros limited the sizing and 
positioning of imported pictures. If you installed the EPS macros on your templates, you must remove them to use 
the new EPS graphics filter, EPSIMP.FLT, with documents attached to those templates. You can remove the old 
EPS macros by deleting the macros called InsertPicture and FilePrint.

Requirements for EPS

The first line in the EPS header (the first line in the EPS file) must be the version comment: "%!PS-Adobe-2.0 
EPSF-2.0" (you can substitute "1.0" for "2.0" in the header). This line indicates that the PostScript language file 
conforms to the Adobe standard.

The following comment must also be present in the EPS header: "%%BoundingBox: LLx LLy URx URy". The LL 
variables represent the border lengths of an EPS graphic.

Some applications can generate printer-specific EPS files by intercepting PostScript output to a file. Unfortunately, 
not all applications strictly follow the standard format as set forth by Adobe. Consequently, a PostScript print file 
generated by a printer driver for one PostScript printer may not be printed correctly on another PostScript device.

The Word for Windows EPS graphics filter is not designed to reinterpret an EPS file's PostScript code to overcome 
nonstandard contents. If an EPS file does not follow the Adobe specification, Word can display a bounding box for 
the image on screen, and when asked to print, send the original PostScript code to the current PostScript printer.

For more information on the Encapsulated PostScript Specification, contact the PostScript Developer Support 
Group at:

Adobe Systems Incorporated
1585 Charleston Road PO Box 7900
Mountain View, CA 94039-7900
(415) 961-4111



PC Paintbrush (.PCX)
The PCX graphics filter PCXIMP.FLT supports all versions of the PCX file format through ZSoft's version 3.0, 
with support for 256-color images. This is the common interchange format used by Microsoft Windows Paintbrush.

The Size of PCX Pictures May Change When Imported into Word

The creating application may include additional white space above, below, and/or to the left or right of the image 
when exporting the picture. You can crop the picture in Word to get the effect you want.

When the creating application exports a PCX file as a virtual bitmap, the resolution option selected during export 
may cause a change in picture size when the image is imported into a Word for Windows document. You can scale 
the image in Word to the size you want.

Note

The filter supports PCX graphics generated by the capture utility included with Word for MS-DOS.



WordPerfect Graphics (.WPG)
The WPG import filter is also used by the WordPerfect document converter to convert graphics embedded in a 
WordPerfect document.

The filter uses the size of the picture frame stored in the WPG file to determine the size of the picture to import. 
The picture-frame size of WPG graphics created by DrawPerfect is the size of the screen.

Options

Retain Background

WPG images often contain a background color that may impair the fidelity of the image when imported into Word. 
By default, the filter will remove this background color to improve clarity. This behavior can be changed by editing 
the MSTXTCNV.INI file located in your Windows directory. The [WPGImport] section of this file includes a 
RetainBackground setting. By assigning a value of 1 to this setting, all background color will be retained upon 
import. Word provides the EditConversionOptions macro to facilitate editing MSTXTCNV.INI. For information on 
using this macro, see To modify conversion options.
Display Progress Meter

When importing WordPerfect documents containing graphics, the default behavior is to not display the progress 
meter for each graphic. This behavior can be changed by editing a setting in MSTXTCNV.INI. Word provides the 
EditConversionOptions macro to facilitate editing MSTXTCNV.INI. For information on using this macro, see To 
modify conversion options.

Limitations

EPS images in WPG format do not maintain PostScript code when inserted into Word.
For bitmap rotation, only 90-degree increments are supported.
WPG files with large embedded bitmaps may have problems displaying when using the Mach series video 

drivers from ATI. If you suspect that this may be happening, try changing your video driver to the 8514/a drivers 
supplied with Windows. You can do this by running Windows Setup.



WordPerfect Graphics Export (.WPG)
When you convert a Word for Windows document to WordPerfect format, this export filter converts Windows 
Metafiles to the WordPerfect Graphic format used by WordPerfect Corporation products . When you want to 
convert a Word document containing graphics to WordPerfect format, the WordPerfect text converter runs this 
filter for each graphic in the Word document and embeds each converted graphic in the WordPerfect document.

Options

Display Progress Meter

When exporting Word documents containing graphics, the default behavior is to not display the progress meter for 
each graphic. This behavior can also be changed by editing a setting in MSTXTCNV.INI. Word provides the 
EditConversionOptions macro to facilitate editing MSTXTCNV.INI. For information on using this macro, see To 
modify conversion options.

Limitations:

EPS pictures are converted by dropping the PostScript code and converting the screen representation.



Windows Bitmaps and Metafiles (.BMP, .WMF)
Word for Windows supports Windows bitmap (BMP) files and Windows metafiles directly, without a separate 
graphic filter. WMF files must be in the Aldus Placeable Metafile format (which contains a header with org and ext 
information).

Aldus and Micrografx have created an extended version of the Windows Metafile Format called the "Placeable 
Metafile Format." In this extended format, 22 bytes of information have been added to the standard metafile 
header. This information allows the metafile to specify how the metafile is to be placed and sized.

The WMF filter rejects files that do not have the correct key, checksum, bounding rectangle and/or enough data in 
the file.



Micrografx Designer/Draw (.DRW)
This graphics filter supports Micrografx Designer version 3.x , Charisma 2.1, and Draw DRW files. By default, the 
DRW filter imports only the entire first page of a file as it would appear in Micrografx Designer, because DRW 
files don't contain information on the size of the image. Once the image is imported, the bounding box may be 
cropped to make it tightly fit the size of the image.

Limitations

Text arrays are not supported.
Some Micrografx Designer 3.x fonts are not supported with this version of the DRW filter.
Clip paths, which require clipping regions, aren't supported in GDI metafiles.
Tiled paths, which permit object-oriented fills to be put behind clip paths, aren't supported.



Computer Graphics Metafile (.CGM)
The Word for Windows 6.0 Computer Graphics Metafile (CGM) import filter, CGMIMP.FLT, can import CGM 
graphic files that conform to version 1 of the CGM specification. This filter is not certified CALS-compliant, but it 
supports most CALS elements.

Supported CGM Elements

The following CGM Graphical Primitive and Attribute Elements are supported:

Line type: standard ANSI set.
Marker type: standard ANSI set.
Edge type: standard ANSI set.
Line elements: polyline, disjoint polyline, circular arc 3 point, circular arc center, and elliptical arc. Pens 

with a physical width greater than one pixel will always have a solid style. A nonsolid-style pen always has a width 
of 1 pixel.

Fill elements: polygon, polygon set, rectangle, circle, circular arc 3, point close, circular arc center close, 
elliptical arc close, and ellipse.

Interior style: solid, pattern, hatch, and empty.
Text elements: text, restricted text, and append text. Attribute changes within a text string are not 

recognized.
Polygon set.

Limitations

The following CGM Graphical Primitive and Attribute Elements are not supported:

Cell array.
Character spacing.
Character orientation.
Character set index (only one character set is used).
Interior style (only hollow and solid are supported).
Pattern table.
Pattern size.
Gradients and bitmap fill patterns.
Strikethrough and underline attributes are not maintained when imported. CGM doesn't support these text 

styles, and this information is lost unless the source application simulates the styles by drawing lines.



Printers and Printing

Following are some common printing questions. Each question is followed by the word ANSWER. To see the 
answer to the question, click ANSWER.

1. When I try to print, nothing happens. What should I do? ANSWER

2. Why don't borders and graphics appear in my printed document? ANSWER

3. Why don't table gridlines appear in my printed document? ANSWER

4. Is there a quick way to cancel printing a document? ANSWER

5. Why do the addresses on my envelopes print in the wrong position? ANSWER

6. How do I change the formatting of envelopes I print in Word? ANSWER

7. How can I increase Word's printing speed? ANSWER

8. I am using a Hewlett-Packard LaserJet IIP with Word and my envelope does not print or it prints incorrectly. 
What can I do? ANSWER

9. How do I get my document to print from a different tray on my printer? ANSWER



Q: When I try to print, nothing happens. What should I do?

A: A printer may fail to print for a wide variety of reasons. Here are some troubleshooting steps to follow:

Make sure that your printer is turned on and that it is online. (There may be a button or switch marked 
"Online.") 

Check both ends of the cable between your computer and printer to verify that the connections are tight. 
Verify that the page range you have selected in the Print dialog box (File menu) corresponds to the pages 

you want to print. 
Make sure that the selected printer matches the printer you are using. Choose Print from the File menu and 

check the active printer.
Check the status of your print job in the Print Manager (Windows). If the print job is stalled, you may be 

able to restart it by choosing the Resume Printing Document command from the Document menu.
Try printing another document. If that document prints, the problem may be related to your original 

document. Copy and paste the contents of your original document into another document and try printing again.
If you are printing over a network, make sure your network connection is intact. Check with your network 

administrator for assistance.
If you still can't print, try to print a file from Write (Windows). If you cannot print with Write, the problem 

is probably affecting all your Windows-based applications. See Calling Microsoft Support Services in the United 
States or Getting Product Support Worldwide.

__________
See also

Printers and Printing



Q: Why don't borders and graphics appear in my printed document?

A: This problem can occur for the following reasons:

You have selected the Draft Output option, which prints a document without formatting or graphics. To 
print the borders and graphics in the document, choose Options from the Tools menu and then select the Print tab. 
Under Printing Options, clear the Draft Output check box.

Make sure that the Drawing Objects option, which prints graphics, is turned on. From the Tools menu, 
choose Options, and then select the Print tab. Under Include With Document, select the Drawing Objects check box.

Word or Windows may be low on memory. See Freeing up memory.
__________
See also

Printers and Printing



Q: Why don't table gridlines appear in my printed document?

A: Table gridlines appear only on the screen. To print vertical and horizontal lines between cells, you must apply 
borders to the table.

The easiest way to apply borders is to use the Table AutoFormat command on the Table menu, which 
automatically applies predefined borders and shading to a table. See Adding borders and shading to a table.

You can also use the Borders toolbar or the Borders And Shading command on the Format menu to create 
custom borders and shading. For more information, see Borders And Shading command.

__________
See also

Printers and Printing



Q:  Is there a quick way to cancel printing a document?

A: Word will stop printing a document if you do one of the following:

If background printing is off, press ESC.
If background printing is on, double-click the printer icon on the status bar, or choose Print from the File 

menu, and then choose the Stop Print button.

              Printer icon

Background printing allows you to continue working in Word while you print a document. Background printing 
uses memory; to speed up printing, clear the Background Printing check box, an option on the Print tab in the 
Options dialog box (Tools menu).

Note
If you are printing a short document, the printer icon may not appear on the status bar long enough to click it to 
cancel printing.
__________
See also

Printers and Printing



Q: Why do the addresses on my envelopes print in the wrong position?

A: An envelope address may not print in the correct location for the following reasons:

You may have selected the wrong printer bin or set other envelope printing options incorrectly.
You may need to adjust the location where Word prints the address on the envelope. You can adjust the 

location of the address in page layout view or print preview.
For information about setting envelope printing options and adjusting the location of the address for a 

single envelope, see Creating and printing an envelope. If you are printing multiple envelopes during a mail-merge 
operation, see Setting up and printing envelopes by using Mail Merge.

__________
See also

Printers and Printing



Q: How do I change the formatting of envelopes I print in Word?

A: Use the following steps to set the positioning and character formatting of envelope addresses and return 
addresses:

1. From the Tools menu, choose Envelopes And Labels.

2. Select the Envelopes tab and then choose the Options button.

3. In the Envelope Options dialog box, select the Envelope Options tab.

4. Modify the character formatting and positioning settings for the delivery and return addresses and then 
choose OK.

If you want to change the default character formatting settings, choose the Default button in the Envelope 
Return Address and Envelope Address dialog boxes.

5. Print your envelope or add it to your document.
__________
See also

Printers and Printing



Q: How can I increase Word's printing speed?

A: Here are six things you can do to increase printing speed in Word:

Use a font stored your printer instead of a downloadable font.
 Make sure there is a SET TEMP statement in your AUTOEXEC.BAT file and that it points to a valid 

directory.
  Make sure there are at least 2 megabytes of free space on your hard disk.

In the Print Manager (Windows), choose Background Printing from the Options menu. Under Printing 
Priority, select the High option.

Free up memory. See Freeing up memory.
Clear the Background Printing check box on the Printing tab in the Options dialog box (Tools). When this 

option is not selected, documents print faster, but you have to wait until Word finishes printing before you can 
continue working.

__________
See also

Printers and Printing



Q: I am using a Hewlett-Packard LaserJet IIP with Word and my envelope does not print or prints 
incorrectly. What can I do?

A: If you are running Windows version 3.1, make sure that the printer selected in the Print Setup dialog box is the 
LaserJet IIP, rather than the LaserJet Series II. If the LaserJet Series II is selected, the envelope address will 
print in the wrong position. 

__________
See also

Printers and Printing



Q: How do I get my document to print from a different tray on my printer?

A: Use the following steps to switch to a different paper tray:

 1. From the File menu, choose Page Setup.

 2. Select the Paper Source tab.

 3. In the First Page and Other Pages lists, select the printer bins you want to use, and then choose OK. 
__________
See also

Printers and Printing
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Overview of File Conversion Limitations and Options

Conversions Limitations

It is not always possible to convert everything in a document, often because a feature is unavailable or 
implemented very differently in Word or in the other application. This topic explains the limitations when 
converting files to and from various file formats. See Conversion Limitations.

For more information on opening files in other file formats, see Converting File Formats in the Word Help file. To 
convert several files at once with a batch macro, see CONVERT.DOT in Supplied Macros. For more information 
on improving compatibility of documents converted from other word processors to Word, see Compatibility 
Options in the Word Help file.

Modifying Conversion Options

By modifying conversion options, you can change how some converters deal with certain document elements that 
you may want to be converted in different ways, depending on the particular documents being converted. This 
topic discusses how to run the EditConversionOptions macro to modify conversion options. For information on 
running this macro, see Modifying Conversion Options.

Font Substitution 

When you convert documents to and from other file formats, you may find that, due to differences in printer 
drivers and installed fonts, the fonts in the original document are not available to the application that is used with 
the converted document. This topic explains how to specify which fonts to substitute when converting documents 
between Word and other applications. For information on substituting fonts, see Substituting Fonts When 
Converting Documents.

Additional Converters 

Converters to convert the following file formats are also available from Microsoft:

MultiMate 3.3, MultiMate Advantage, MultiMate Advantage II, and MultiMate 4.0
DisplayWrite versions 4v1, 4v2, and 5.0 (import only)
Lotus 1-2-3 version 2.x and 3.x
Microsoft Publisher version 2.0
Microsoft Word for Windows 1.x (required for export only)
Microsoft Works for MS-DOS
Microsoft Word for MS-DOS Glossary Conversion
Microsoft Works for Windows
Microsoft Multiplan versions 3.x and 4.2
WordStar versions 3.3, 3.45, 4.0, 5.0, 5.5, 6.0, and 7.0 
WordPerfect versions 4.1 and 4.2 

For information on converting to and from these formats, see SCNVINFO.DOC, on the Supplemental Conversions 
Disks. For information on supplemental graphics filters, see Overview of Graphics Filters.

To obtain the Supplemental File Conversion disks (one 5.25-inch [1.2 MB] and one 3.5-inch disk [1.44 MB]) free 
of charge, see the "Microsoft Word for Windows Supplemental Offers" coupon included in your Word for 
Windows package. If you cannot locate this coupon, please call the Microsoft Sales Information Center at (800) 
426-9400. Deaf or hard-of-hearing customers can call Microsoft Text Telephone (TT/TDD) services at (800) 892-
5234.

These converters are also available for downloading from the Microsoft Download Service or from the MSWord 
Forum Files Library on CompuServe. For more information on accessing these services, see Using the Microsoft 
Download Service and Using Microsoft Forums on CompuServe.



Conversion Limitations

Conversion limitations are listed in table format. The features are organized by type of formatting: character, 
paragraph, column, page, table, or document. The tables list only features that are not converted, are not supported 
in one product or the other, or that require some comment. "Yes" means the feature exists in both products and is 
converted from one product to the other. "No" means it exists in both products but is not completely converted 
between the two. "N/S" means the feature is not supported in one of the products or is not converted completely 
between products.

Converting From Microsoft 6.0 to Microsoft Word for Windows 2.0

Converting Between Microsoft Word 6.0 and Microsoft Word for the Apple Macintosh Versions 4.0 and 5.  x  

Converting Between Microsoft Word 6.0 and Microsoft Word for MS-DOS

Converting Between Microsoft Word 6.0 and WordPerfect 5.0, 5.1, and 5.2

 Converting Between Microsoft Word 6.0 and Microsoft Write for Windows

Converting from Microsoft Excel to Microsoft Word 6.0

Converting Between Microsoft Word 6.0 and RFT-DCA

Converting Between Microsoft Word 6.0 and Text with Layout



Converting From Microsoft Word for Windows 6.0 to Microsoft Word for Windows 2.0
Word 6.0 reads all previous formats of Word for Windows directly. This section discusses problems or limitations 
that may arise when converting Word 6.0 documents into Word 2.0 format, either by saving as Word for Windows 
2.0 format or by reading the Word for Windows 6.0 document into Word 2.0.

Feature
Word 6.0 to 
Word 2.0 Comments

Character Formatting

Superscript/Subscript N/S This property is emulated with 
raised/lowered.

Expand/Condense Yes Word 6.0 supports finer control over 
this. The value is rounded to the 
closest value Word 2.0 supports.

Underline Yes Dotted-underline formatting is not 
supported in Word 2.0

Kerning  N/S

Paragraph Formatting

Borders, shading See comment Word 6.0 has more borders and 
shading options than Word 2.0. Word 
6.0 borders are mapped to the closest 
approximation in Word 2.0. 

Other Features

Cell borders, shading See comment Word 6.0 has more borders and 
shading options than Word 2.0. Word 
6.0 borders are mapped to the closest 
approximation in Word 2.0. 

Fields See comment Word 6.0 has additional fields and 
field switches. These are preserved in 
conversion along with the current 
results. If these fields are updated, 
the results may be lost. Reopening 
the file in Word 6.0 and updating the 
fields will restore the result.

Drawing Layer No All drawn objects are lost.

Form Fields See comment Results of text fields are displayed. 
Other form fields and bar code fields 
have no result to display.

Styles See comment Word 2.0 allows only 223 user-
defined styles. Style numbers greater 
than that and style references to them 
are not retained, although the 
formatting is.

Endnotes Yes All footnotes and endnotes are 
retained, but they are merged into 
one continuous stream.

Bullets/Numbering Yes Automatic bullets and numbers are 
converted to plain text.

Character Styles No Style definitions are lost, although 
formatting is retained.



Bar Tabs No

Mail Merge See comment When opening Word 6.0 documents 
in Word 2.0, mail merge documents 
(main documents, header sources, 
and data sources) lose their 
association with each other. This 
association can be restored by 
running Print Merge again.

Master Documents No Master documents lose the contents 
and association with the 
subdocuments. Subdocuments are 
automatically converted into separate 
files if you save as Word 2.0. 
Reading in Word 6.0 files will only 
convert the master document.

Revision marks see comments Multiple author/color revision marks 
convert to single color.

Variable-width 
Columns

N/S Variable-width columns are mapped 
to equal-width columns.

Bookmarks & 
References

See comment Word 6.0 allows greater flexibility in 
naming bookmarks. These are 
converted as closely as possible 
along with the corresponding 
references.

Page Numbering See comment Word 6.0 has more page numbering 
options than Word 2.0. These are 
mapped to the closest alternative in 
Word 2.0

 



Converting Between Microsoft Word for Windows 6.0 and Microsoft Write for Windows
After converting a Write document to Word 6.0 and back, it may appear that objects were lost in the conversion. If 
this happens, simply repaginate the final document within Write, and the objects should reappear.



Converting Between Microsoft Word 6.0 and Microsoft Word for the Apple Macintosh 
Versions 4.0 and 5.x
To ensure specific translation of fonts, font-mapping is recommended. See Substituting Fonts When Converting 
Documents. Also included in that topic are special font-mapping instructions for Microsoft Word for the Apple 
Macintosh, version 4.0.

Feature

Word 6.0 to 
Word for the 
Macintosh

Word for the 
Macintosh to Word 
6.0 Comments

Character Formatting

Outline N/S See comment Converted to normal text in Word 
6.0.

Shadow N/S See comment Converted to normal text in Word 
6.0.

Superscript/Subscript See comment Yes Word 6.0 superscript/subscript is 
different from previous versions of 
Word. This property is emulated 
using raised/lowered character 
formatting.

Kerning No N/S

Expand/Condense See comment Yes Word 6.0 supports finer control of 
this property. This value is rounded 
to the closest value that Word for the 
Macintosh supports.

Paragraph Formatting

Borders/Shading See comment Yes Word 6.0 has more options for 
borders and shading than Word for 
the Macintosh, including color. 
These are mapped to the closest 
Word for the Macintosh value 
available.

Columns

Columns Yes Yes Line Between not converted.

Variable-width 
Columns

See comment N/S Variable-width columns are mapped 
to equal-width columns in Word for 
the Macintosh.

Page Formatting

Page formatting for Word for the Macintosh documents is stored in the Macintosh print record. On export, the 
converter is unable to create a print record.

Page orientation No Yes

Page size No Yes

Paper source No Yes

Section Formatting

Line numbering
(Start At #)

No N/S

Vertical alignment
(top, centered, justified)

No N/S



Other Features

Annotations See comment Yes Annotations are retained when 
converting to Word for the Macintosh 
version 5.1; otherwise, annotations 
are converted to footnotes. 

Fields (FILENAME) No N/S

Graphics See comment Yes When converting from Word 6.0 to 
Word for the Macintosh version 5.x, 
graphics are retained, provided the 
conversion is performed from within 
Word for the Macintosh.

When converting to Word for the 
Macintosh version 4, an empty 
graphics frame is created in the Word 
for the Macintosh document.

Language No N/S

Revision marks No N/S Character formatting indicating 
revised text is retained.

Subdocuments 
(INCLUDE field)

See comment N/S If the RetainInclude flag is set to Yes 
in the [MacWordConv] section of 
MSTXTCNV.INI, then the include 
field will be converted; however, any 
path information in the field will be 
lost. Otherwise the latest result is 
inserted in the Word for the 
Macintosh document and the 
INCLUDE field is lost.

Master Documents No N/S Master documents lose the contents 
of the subdocuments and the 
references, but all the subdocuments 
are converted at the same time as the 
master document into separate 
documents.

Cross-references and 
bookmarks

No N/S

Object linking and 
embedding

Yes Yes OLE objects may be edited after 
conversion, providing the OLE 
server is available on the target 
platform.

Drawing layer No N/S

Cell borders/shading See comment Yes Word 6.0 has more options for 
borders and shading than Word for 
the Macintosh, including color. These 
are mapped to the closest Word for 
the Macintosh value available.

Fields (Form and bar 
code fields)

See comment N/S Results of text form fields are 
retained. Other fields have no result 
that can be displayed.

Styles See comment See comment Word for the Macintosh allows only 
255 defined styles. Style definitions 



numbered greater than that are 
omitted, along with any references to 
them. All formatting is preserved, 
however.

Character Styles No N/S Character style definitions are lost. 
All formatting is retained.

Bullets/
Numberin
g

See 
comment

N/S Automatic 
bullets/nu
mbers are 
converted 
to plain 
text.

Endnotes See 
comment

N/S All 
footnotes 
and 
endnotes 
are 
retained, 
but they 
are merged 
into one 
continuous 
stream.

Page Numbering See comment Yes Word 6.0 has more page numbering 
options than Word for the Macintosh. 
These are mapped to the closest 
alternative.

Extended Characters See comment See comment Some ANSI extended characters have 
no Macintosh character set 
equivalent, and vice versa. If the 
equivalent character is not available, 
it is replaced by the underscore (_) 
character. Equivalent characters 
available in fonts such as Symbol or 
Wingdings can be used to replace lost 
characters following conversion.

Characters available in the unique 
symbol sets of Microsoft TrueType 
fonts are retained, provided that the 
same font is available on both 
platforms.

Options for the Word for the Macintosh Converter

These options are stored in the [MacWordConv] section of the MSTXTCNV.INI file located in your Windows 
directory. Word provides the Edit Conversion Options macro to facilitate editing MSTXTCNV.INI. For 
information on using this macro, see To modify conversion options.

Option Setting Comment

ConvertMerge= Yes/blank

No

Converts chevron characters as print merge fields.

Converts chevron characters as literal text.

FontDialog= Yes/blank

No

Dialog boxes for user-defined font-mapping files for 
Word for the Macintosh version 4.0 files are used.

Dialog boxes for user-defined font-mapping files for 
Word for the Macintosh version 4.0 files are not 
used.

RetainInclude= Yes/blank Converts INCLUDE fields as well as their results.



No Converts INCLUDE field results only.



Converting Between Microsoft Word 6.0 and Microsoft Word for MS-DOS
Following this table are information and procedures on converting styles and graphics between the products.

Feature

Word 6.0 to 
Word for 
MS-DOS

Word for 
MS-DOS 
to Word 6.0 Comments

Character Formatting

Color Yes Yes If the same colors are not present in 
both word processors, the closest 
color or pattern is used.

Underline (word) No N/S Word 6.0 word and dotted 
underlining become single 
underlining in Word for MS-DOS.

Spacing (condensed, 
expanded)

No N/S Word 6.0 condensed and expanded 
characters become normal characters 
in Word for MS-DOS.

Subscript/superscript Yes Yes Word for MS-DOS superscript and 
subscript are automatically offset 
above or below the character baseline 
by 3 points. For more information, 
see Modifying Conversion Options

Columns

Line Between No N/S Line Between formatting in Word for 
Windows is not converted to Word 
for MS-DOS.

Uneven columns See comment See comment Word for MS-DOS only supports 
even-width columns so Word 6.0 
uneven columns become even when 
converted to Word for MS-DOS.

Document Formatting

Default tab stops No Yes See the information on the MWINI 
switch in [Conversion Options] in the 
MSTXTCNV.INI File. You can 
change conversion options using the 
EditConversionOptions macro. For 
more information, see Modifying 
Conversion Options.

Footnote position See comment Yes Word for MS-DOS does not support 
footnotes beneath text; those are 
converted to end-of-page footnotes. 
Endnotes become footnotes in Word 
for MS-DOS.

Summary Info Yes Yes Word for MS-DOS has no SUBJECT 
field. Word for Windows has no 
OPERATOR field.

Widow control No Yes See the information on the MWINI 
switch in [Conversion Options] in the 
MSTXTCNV.INI File. You can 
change conversion options using the 
EditConversionOptions macro. For 



more information, see Modifying 
Conversion Options.

Page Formatting

Page orientation Yes Yes Word for MS-DOS supports portrait 
and landscape orientation in the same 
document only for printers that 
support autorotation.

Paper source N/S No

Paragraph Formatting

Page break before Yes N/S Word 6.0 Page Break Before 
formatting is converted to manual 
page breaks in Word for MS-DOS.

Line spacing Yes Yes For more information, see Modifying 
Conversion Options.

Section Formatting

Line numbering
(Start At #)

No N/S Word for MS-DOS line numbers 
always start at 1.

Vertical alignment (top, 
centered, justified)

Yes No

Page numbers Yes Yes Word for MS-DOS page numbers are 
put in a header or footer in Word 6.0.

Tables

Tables Yes Yes Word 6.0 tables become side-by-side 
paragraphs in Word for MS-DOS 
version 5.5 and earlier, and vice 
versa. Multiple conversions of the 
document may result in changes to 
the left and right indents.

Other Features

Bookmarks See comment Yes Word 6.0 bookmark names longer 
than 20 characters are not converted 
in Word for MS-DOS.

Fields (DATE, TIME, 
FILENAME)

Yes Yes Word 6.0 supports more date and 
time formats than Word for MS-
DOS. The FILENAME field is not 
supported in Word for MS-DOS.

Page number format Yes Yes Word 6.0 supports more page number 
formats than Word for MS-DOS.

Footnotes (separators, 
continuation notices)

See comment See comment Word for MS-DOS footnote 
separators cannot be modified. 
Continuation notices are not 
supported in Word for MS-DOS.

Graphics (scaling, 
cropping)

See comment See comment Links to graphics in Word 6.0 are 
converted to Word for MS-DOS if 
the graphic format is supported in 
Word for MS-DOS. For more 
information, see "Converting 



Graphics," later in this topic.

Language Yes Yes Legal, medical, and user-defined 
dictionaries will convert to the 
default language.

Color Yes Yes If the same colors are not present in 
both word processors, the closest 
color or pattern is used.

Underline (word) No N/S Word 6.0 word and dotted 
underlining become single 
underlining in Word for MS-DOS.

Spacing (condensed, 
expanded)

No N/S Word 6.0 condensed and expanded 
characters become normal characters 
in Word for MS-DOS.

Subscript/superscript Yes Yes Word for MS-DOS superscript and 
subscript are automatically offset 
above or below the character base 
line by 6 points.

Using Word for MS-DOS Styles in Word for Windows

In Word for MS-DOS, styles are stored in a style sheet file that is attached to the Word file. When you convert a 
document from Word for MS-DOS to Word for Windows format, the conversion filter looks for the style sheet file 
that was attached to the original document. If that style sheet file is found, paragraph and character styles used in 
the Word for MS-DOS document are stored in the Word for Windows document; the Word for MS-DOS Style ID 
becomes the Word for Windows style name. If the style sheet file is not found, the converter prompts you for the 
file's location. You can either specify the location or choose not to. If you choose not to specify the style sheet file 
location, all formatting applied with styles in the Word for MS-DOS document is converted to direct formatting.

You can add the styles in the converted document to a Word for Windows template and use the template to create 
other Word for Windows documents. If a style with the same name as the Word for MS-DOS style already exists in 
the active template in Word for Windows, the Word for MS-DOS style overrides the Windows style.

If you do not wish to be prompted for missing style sheet files, you can modify the functionality of the Word for 
MS-DOS converter so that this message is not displayed. For more information, see the discussion of the Word for 
MS-DOS StyleDialog option in the EditConversionOptions macro stored in the CONVERT.DOT template. The 
Word for Windows Setup program installs CONVERT.DOT in the MACROS subdirectory of the Word program 
directory. For more information, see Modifying Conversion Options.

You can add the styles in the converted document to a Word for Windows template in the same way that you can 
add styles from a Word for Windows document and use the template to create other Word for Windows documents. 
For more information, see Copying styles, AutoText entries, toolbars, or macros to the attached template from 
another template.

Using Word for Windows Styles in Word for MS-DOS

To convert style formatting in a Word for Windows document into a Word for MS-DOS style sheet, use the Save 
As command on the File menu to save the file in Word for MS-DOS format. When you save the document in Word 
for MS-DOS, you are asked if you want to attach a style sheet to the document. You can do any of the following:

Create a new Word for MS-DOS style sheet to contain the styles from the Word for Windows document 
template.

Ignore all styles. If you ignore styles, the style formatting from the original Word for Windows document is 
converted to direct formatting in the Word for MS-DOS document.

Attach an existing Word for MS-DOS style sheet.



If you attach an existing Word for MS-DOS style sheet, text formatted with a standard style retains the formatting 
of a Word for MS-DOS style with the same name. If no Word for MS-DOS style with the same name exists, 
standard styles are converted as direct formatting.

If the style does not exist in the Word for MS-DOS document, the converter merges the style.

Converting Word for MS-DOS Glossaries

Macros for converting Word for MS-DOS glossary files to Word for Windows 6.0 autotext entries are available on 
the Supplemental Conversions Kit. See SCNVINFO.DOC in the kit for more information.

Converting Graphics

Microsoft Word for Windows and Word for MS-DOS both support TIFF, HPGL, EPS, PCX, and Lotus PIC graphic 
file formats. Links to any of these graphics contained in a Word for MS-DOS document are automatically 
converted to Word for Windows INCLUDEPICTURE fields, and vice versa. Links are lost for formats not 
supported by Word for MS-DOS.

Word for MS-DOS includes graphics by specifying a tag that consists of the path and filename of the graphics file 
to be included in the document. For example, a tag may look like the following:

.G.C:\WINWORD\FILENAME.PCX;6";1.158";PCX

These tags are converted to Word for Windows graphics fields. For example:

{includepicture C:\\WINWORD\\FILENAME.PCX \* mergeformat}

For a graphic to appear in a converted document, the appropriate graphic filter must be installed in Word for 
Windows, and the original graphic file must remain in the path specified in the converted document's 
INCLUDEPICTURE field.

Additional Graphics Considerations

Word for Windows may not recognize graphics created using the Word for MS-DOS CAPTURE.COM utility. 
These files have a .SCR filename extension by default. (CAPTURE.COM also creates ASCII text files which have 
a .LST extension by default.)

Linked graphics in PageView file format become bitmaps. These files have a filename extension such 
as .PO1, .PO2, .PO3, and so on. 

Large bitmaps in Word for Windows cannot be displayed or printed in their entirety; they are divided into sections 
marked by white lines.

For more information on graphic filters, see Importing Graphics and Overview of Graphics Filters.



Converting Between Microsoft Word 6.0 and WordPerfect 5.0, 5.1, and 5.2
To ensure specific translation of fonts, font-mapping is recommended. See Substituting Fonts When Converting 
Documents.

The WordPerfect 5.x converter shipped with Word for Windows 6.0 is designed to take advantage of features and 
conversion capabilities specifically available in Word for Windows 6.0. For best results converting to and from 
Word for Windows 6.0, use the WordPerfect 5.x converter shipped with Word for Windows 6.0.

Note
Converting a file from Word format to WordPerfect format and back again may cause the loss of some formatting 
(i.e., fonts, justification, styles, and mail merge) unless you load, paginate, and save the converted file in 
WordPerfect before converting back to Word.

Feature
Word 6.0 to 
WordPerfect

WordPerfect
to Word 6.0 Comments

Character Formatting

All caps Yes N/S All caps formatting becomes all 
capital letters.

 Hidden Yes N/S Hidden text in Word becomes 
WordPerfect Comment text.

Strikethrough See comment See comment WordPerfect strikeout becomes 
strikethrough formatting in Word; 
WordPerfect redlining becomes 
revision marking in Word. Word 
strikethrough formatting converts to 
strikeout in WordPerfect; Word 
revision marking converts to 
WordPerfect redlining.

Underlining Yes Yes Underlining format is preserved, but 
the type of underlining may be 
changed.

Spacing (condensed, 
expanded)

No N/S

Kerning Yes Yes

Paragraph Formatting

Alignment Yes Yes Centering codes may have to be 
individually repositioned in 
WordPerfect after conversion.

First-line indents Yes Yes First-line indents are created with 
tabs in WordPerfect.

Page Break Before Yes N/S Approximated with a page break in 
WordPerfect.

Space before/after 
paragraphs

Yes N/S Approximated with blank lines in 
WordPerfect.

Tab leaders See comment Yes All Word tab leaders become dot 
leaders in WordPerfect.

Leading/baselines, 
Lines/baselines

N/S No

[Center]/[Flsh Rgt] 
codes

N/S See comment From WordPerfect to Word, Center 
and Flush Right codes convert to 
center and right-aligned tab stops.



Section Formatting

Headers/footers Yes Yes Last header/footer/page number 
defined for a position is used; all 
others are lost. 

Margins Yes Yes Word margins are measured from the 
paper's edge to body text; 
WordPerfect margins are measured 
from the edge to the header. The 
conversion adjusts the margins as 
needed to preserve page layout. If 
problems are experienced with 
margins (for example, if they are set 
outside the printable range in Word), 
choose Page Setup from the File 
menu, select the Margins tab and 
click OK. If margins need to be 
adjusted, Word will ask to fix them.

Line numbering Yes Yes From Text is not converted.

Page numbering (Start 
At)

No No

Vertical alignment See comment No Converted for first page only.

Newspaper Columns Yes Yes Line Between formatting is not 
supported by WordPerfect.

Parallel Columns N/S See comment From WordPerfect to Word, parallel 
columns convert to tables. If a 
parallel column layout contains a 
page-anchored box, the entire 
parallel column converts to 
newspaper columns.

Tables

Tables Yes Yes Vertical merging of cells is not 
converted.

Table Formulas/Math No No
Vertical Table Cell Merge N/S No
Decimal table cell 
alignment

N/S See comment Converted to right paragraph 
alignment.

 Document Formatting

Default tab stops No Yes

Footnotes Yes Yes Footnotes placed at end of sections 
are converted to endnotes since 
WordPerfect doesn't have sections. 
Starting number and separators are 
not converted. Custom footnote 
marks are added to automatic 
numbering.

Gutter Margins, Widow 
Control, Mirror 
Even/Odd Pages, Paper 
Size

Yes Yes Widow Control is a document 
property in Word; Even/Odd pages is 
not converted.



Other Features

Annotations Yes N/S Annotations become WordPerfect 
Comment text.

Outlining/Paragraph 
Numbers/Word 6.0 
Lists

Yes Yes Paragraph numbers convert to 
sequence fields when present in 
Tables, Footnotes, and other non-
body text locations. Word Lists 
convert to paragraph numbers.

Print merge commands Yes Yes Word data source documents can be 
either tab or comma delimited or in 
table format to convert to 
WordPerfect. Word automatically 
converts WordPerfect secondary files 
to Word data source document 
format. Conditional print merge 
constructs and macros are lost when 
converting to Word.

Date/time stamps Yes Yes Default formats only. 

Subdocuments 
(INCLUDE field) 

Yes See comment WordPerfect master documents and 
subdocuments convert to Word 
master documents and 
subdocuments. Word master 
documents and subdocuments 
convert to WordPerfect master 
documents and subdocuments.

Equations See comment See comment From Word to WordPerfect, equation 
objects are converted as editable 
equation boxes. Equation fields are 
not converted from Word to 
WordPerfect. From WordPerfect to 
Word, equations are converted as 
editable equation objects.

Extended characters Yes Yes Extended characters that are 
available in both products are 
converted.

Text Boxes/Lines Yes Yes Some text boxes and lines convert to 
Word drawing layer objects. Drawing 
layer objects are only visible in page 
layout view and print preview, and 
when printing. Drawing layer objects 
will not appear in normal view.

Line Draw Yes Yes Line Draw characters are converted; 
however, Word's line spacing causes 
gaps to appear between line draw 
characters on successive lines. This 
can be corrected for printing by 
setting line spacing to the exact 
current font size in points. Choose 
Paragraph from the Format menu to 
change line spacing.

PRIVATE field codes N/S See comment PRIVATE fields are inserted by the 
WordPerfect converter to preserve 



information needed to accurately 
save the file back to WordPerfect 
format. These fields should not be 
edited and have no effect on the 
document.

Styles Yes See comment From WordPerfect to Word, styles 
containing paragraph formatting 
codes convert to paragraph styles. 
WordPerfect styles containing only 
character formatting convert to 
character styles in Word. Text 
contained in a style is converted as 
normal text.



Converting Between Microsoft Word 6.0 and RFT-DCA
To ensure specific translation of fonts, a font-mapping file is recommended. See Substituting Fonts When 
Converting Documents.

Feature
Word 6.0 to 
RFT-DCA

RFT-DCA to 
Word 6.0 Comments

Character Formatting

Size See comment See comment Pitch is converted to points in Word, 
and vice versa.

Language No N/S

Color No Yes

Hidden See comment N/S Hidden text is converted to RFT-
DCA underline.

Small caps See comment N/S Small caps are converted to all caps 
in RFT-DCA.

Strikethrough See comment See comment When converting to RFT-DCA, the 
Strikethrough option is used to 
specify the overstrike character used. 
See Modifying Conversion Options.

Revision marks No No When converting to Word, 
strikethrough formatting is 
converted, whereas overstrike 
characters are ignored.

Underline (double, 
single, word) 

See comment Yes All underlining options are converted 
to single underlining in RFT-DCA.

Spacing (condensed, 
expanded)

No N/S

Paragraph Formatting

Alignment Yes Yes RFT-DCA handles alignment of text 
line by line, not by paragraph.

Borders (double, single, 
shadow, and shading)

No N/S

Keep With Next Yes Yes Word 6.0 Keep With Next formatting 
is converted to RFT-DCA "keep" 
property.

Paragraph/break before Yes Page Break Before formatting is 
converted to separate hard page 
breaks before the paragraph in RFT-
DCA.

Space before/after para See comment Space before and after is simulated 
with blank lines.

Tab (decimal) See comment See comment RFT-DCA can align any characters 
with a period or a comma. Word 6.0 
can decimal align only with numeric 
characters and periods.

Section Formatting

Section RFT-DCA has no section formats.

Columns See comment See comment The only column conversion 



supported is RFT-DCA fixed 
columns of equal length to Word 6.0 
columns. 

RFT-DCA Flowing Balanced 
columns convert to Word 6.0 
columns followed by a continuous 
section break (creates a balancing 
effect). RFT-DCA Flowing, but not 
Balanced, columns convert to Word 
6.0 columns. RFT-DCA Related Text 
Columns convert to Word 6.0 Tables.

Headers/footers See comment Yes Different First Page is not converted.

Line numbering No No

Vertical alignment No N/S

Document Formatting

Footnotes See comment Yes All footnotes are positioned at 
bottom of page when converting 
from Word 6.0 to RFT-DCA.

Margins Yes Yes Margins are emulated as closely as 
possible, but may not convert exactly 
due to font differences and 
differences in the layout options of 
Word 6.0 and RFT-DCA.

Widow control No No Widow control is always set to "on" 
during conversion.

Mirror Margins, 
Even/Odd Pages

No N/S Even and odd headers and footers are 
supported.

Page size Yes Yes

Other Features

Absolute-positioned 
objects

No N/S

Annotations No N/S

Styles See comment N/S Styles are converted to direct 
formatting.

Outlining See comment See comment Appearance is preserved.

Tables See comment N/S Tabular columns and word-wrap 
columns convert to Word 6.0. Word 
Tables convert to RFT-DCA Related 
Text Columns.

Indexes/Tables of 
Contents

See comment See comment Appearance is preserved.

Print Merge commands No No

Date/time stamps Yes Yes TIME fields are ignored by RFT-
DCA.

Page number Yes Yes Page numbers are converted, but not 
page number formatting.

Subdocuments 
(INCLUDETEXT field) 

See comment No The latest result is inserted and the 
INCLUDETEXT field is lost.



Cross-references and 
bookmarks

No N/S

Formulas No N/S

Graphics No No If you encounter difficulties saving a 
file containing graphics as RFT-DCA 
format, try double-clicking the 
graphics, then returning to the 
document before saving.

Extended characters Yes Yes Converted when available in 
EBCIDC character sets 256 and 259 
and ANSI. ANSI publishing 
characters are not converted back and 
forth.

Stop Codes and 
Prompted Stop Codes

N/S No

Auto Text No N/S

Linedraw See comment Yes Word 6.0's line spacing causes 
vertical gaps in converted line drawn 
objects that span multiple lines. To 
eliminate the gaps for printing, 
change the line draw paragraph's line 
spacing to exactly the current font 
size in points. To set line spacing, 
choose Paragraph from the Format 
menu.

Font Mapping See comment Yes See Substituting Fonts When 
Converting Documents. Fonts 
convert to Courier New by default in 
Word 6.0, but the original font names 
are preserved and exported to the 
correct font when saved again as 
RFT-DCA.



Converting Between Microsoft Word 6.0 and Text with Layout

Feature

Word 6.0 to Text 
with 
Layout

Text with Layout 
to 
Word 6.0 Comments

Character Formatting

Character No No Character formatting is not 
converted. This includes font, font 
size, color, bold, italic, small caps, 
hidden, underline, word underline, 
double underline, subscript, 
superscript, expanded, and 
condensed character formats. When 
saving to or reading from an MS-
DOS-based application, the MS-DOS 
Text with Layout format should be 
used.

Columns

Columns See 
comment

Line 
Between 
formatting 
is not 
converted.

Document 
Formattin
g

Document

See 
comment

Widow 
control is 
not 
converted.

Page Formatting

Page Page dimensions are not converted. 
Page breaks are not preserved.

 Paragraph Formatting

Borders, Keep Lines 
Together, Keep With 
Next, Page Break 
Before

No N/S

Tab Leaders No No

Section Formatting

Section breaks (even, 
odd, continuous, next 
page)

No N/S

Headers/footers See comment N/S The text of a header/footer is placed 
at the beginning of the document.

Different Odd and Even 
Pages

See comment N/S When different odd/even headers are 
defined in the document, the text of 
the even header is placed at the start 
of the converted document, and the 
text of the odd header is lost. If only 
an odd header is defined in the 
document, the text of the odd header 
is placed at the start of the converted 
document.

Different First Page See comment N/S If a first-page and other header are 
defined, the text of the non-first-page 



header is placed at the beginning of 
the converted document, and the text 
of the first-page header is lost.

Position See comment N/S Header/footer distance from the page 
edge is not preserved. Footers are 
placed at the beginning of the page.

Line numbering No

Page numbering (Start 
At)

No

Tables

Borders, row 
formatting, row height

See comment N/S Borders are not converted. Justified 
text alignment is not converted. 
Minimum row height is not 
converted.

Indents See comment N/S Right indents and hanging indents 
applied within table cells are not 
retained.

Tables Table text and structure are preserved 
in conversion to text.

Other Features

Annotations See comment No Annotations are inserted at the end of 
the document in the order they 
appear in the document.

Fields (DATE, TIME) See comment Fields are converted to the text of the 
last result.

Footnotes Footnotes are inserted at the end of 
the document in the order they 
appear in the document. Footnotes 
are numbered sequentially 
throughout the whole document. Text 
of custom separators is inserted at the 
beginning of the document.

Graphics See comment Bitmaps and metafiles are not 
converted.

Formulas No

Hard space See comment Converted to normal space.

Nonbreaking hyphen See comment Converted to normal hyphen.

Optional hyphen No



Converting from Microsoft Excel to Microsoft Word 6.0
Use the File command on the Insert menu or the Open command on the File menu to open a Microsoft Excel 
worksheet in Word. The converter functions in one direction only. Data may be brought in from Microsoft Excel 
worksheets, but not saved in Microsoft Excel format.

Feature (From Excel to
Word only) Comments

Formatting

Fill Specified fill character(s) become left aligned.

Row height Each row takes on the height of the cell that 
contains the most text.

Column width Most columns retain their width. Hidden columns 
and zero-width columns become a standard width.

Hidden columns Converted as regular table columns.

Numeric formatting

Regular Excel formats Numbers formatted for general format will try to fit 
into the current column width. These numbers are 
brought in at full precision. This may result in more 
decimal places than are displayed in the worksheet.

User-defined formats The "?" and "*" (asterisk) characters are not 
supported when used to define fractional number 
formats. For example, if the value of a cell were 
0.5, and the user-defined number format were 
"# ?/?," Microsoft Excel displays 1/2; Word will 
display 0.5

Worksheet Size

Less than 32 columns A table is created in Word.

More than 32 columns or 
wider than 22 inches

The worksheet is represented in Word as tab-
delimited text.

Notes on Converting from Excel 4.0

Excel 4.0 allows you to press ALT+ENTER to begin a new line within a text cell. The resulting newline 
character is translated to a paragraph mark in a table if the original Excel worksheet width is 32 columns or less, or 
to a newline character in tab-delimited text. These conversions ensure mail-merge compatibility.



Modifying Conversion Options

If a document isn't converted the way you'd like it to be, you may be able to change some aspects of the conversion 
with the EditConversionOptions macro. Depending on the converter you're using, you may be able to specify such 
things as the preferred line length or how you want certain fields to be converted. To view and edit available 
options, run the EditConversionOptions macro in the CONVERT.DOT template (the Word Setup program stores 
this template in the MACROS subdirectory of the Word program directory). The options you set are saved in the 
MSTXTCNV.INI file in the Windows directory. See To modify conversion options

Improving Word's Compatibility With Other Word Processors

In addition to modifying conversions, you can set compatibility options to make Word behave the way another 
word processor does with respect to certain features when working on a document converted from another word 
processor. These options, unlike the conversion options, do not change the document, but merely the way it works 
in Word. For more information, see Chapter 26, "Converting File Formats," in the Microsoft Word User's Guide, or 
see Compatibility Options in the Word Help file.



Substituting Fonts When Converting Documents

If a converted document contains fonts that aren't available on your computer or with your printer driver, Word 
automatically substitutes similar fonts. However, you may find that line breaks, page breaks, and the length of the 
converted document don't match the original document. You can control which fonts are substituted when 
converting documents to or from Word for Windows. 

To control font substitution when converting documents from other applications to Word, see Improving 
compatibility with a document created in a different file format in the Word Help file, or Chapter 26, "Converting 
File Formats," in the Microsoft Word User's Guide.

To control font substitution when converting documents from Word to other applications, you modify a font-
mapping file that is supplied with Word. The font-mapping files listed in the following table are supplied. To 
customize a file, open it in Word and follow the instructions contained in the file itself. Save the customized file 
with the same filename and the filename extension .DAT in the directory where the text converter is located, 
usually the MSAPPS\TEXTCONV subdirectory of the Windows program directory.

Alternately, the font-mapping file may be placed in the same directory as the file is being saved to.

To convert from Word for 
Windows into this format Modify this file

Word for MS-DOS RTF_PCW.TXT

Word for the Macintosh 5.x RTF_MW5.TX
T

RFT-DCA RTF_DCA.TXT

WordPerfect 5.x RTF_WP5.TXT

Translating Between Word for Windows and Word for the Macintosh 4.0
Font mapping for Word for the Macintosh 4.0 files is different from font mapping for Word for the Macintosh 5.x 
and other converters. Macintosh Word version 4.0 stores font information in document files by the Macintosh 
System font numbers. These numbers can be assigned by the user to arbitrary fonts installed in the Macintosh 
System by the user. This means that character font information in the converted Word for the Macintosh files can 
be different for every user and the converter may not make the correct font conversion.

Note
An application note titled "Mac Font Font-Mapping Utility," which enables identification of the Macintosh System 
font numbers and matching font names on your Macintosh computer, is available from Product Support Services. 
For information on contacting Product Support Services, see Calling Microsoft Support Services in the United 
States or Getting Product Support Worldwide.

When opening Word for Macintosh 4.0 documents in Word for Windows, fonts with numbers greater than 128 are 
mapped to font names with the following syntax: "Font<font number>", so font number 2001 and 2001 would 
become "Font2000" and "Font2001" respectively.

Font Mapping Dialog

The Word for the Macintosh converter has an option to determine whether a dialog will be displayed in order to 
locate the font-mapping file.    This behavior is controlled via the following FontDialog setting in the 
[MacWordConv] section in the MSTXTCNV.INI file, described in the following table:

FontDialog= Yes/blank

No

Dialog boxes for user-defined font-mapping files for 
Word for the Macintosh version 4.0 files are used.

Dialog boxes for user-defined font-mapping files for 
Word for the Macintosh version 4.0 files are not 



used.

For more information on changing these options, please see Modifying Conversion Options.

Format of a Word for the Macintosh 4.0 Font-Mapping File

The font-mapping file, MAC_FONT.DAT, should consist of a series of entries in the following format:

Winfontname;MacFont#[FontFamilyID]

The semicolon is required. There can be an arbitrary number of spaces between Winfontname, the semicolon, 
MacFont#, and FontFamilyID. Each entry must appear on its own line. There can be an arbitrary number of blank 
lines between entries.

Winfontname

The Winfontname is the name of the Windows font that will be replaced in Word for the Macintosh by the 
associated MacFont# when converting to a Word for the Macintosh 4.0 document from Word for Windows. If a 
Winfontname has more than one associated MacFont#, then the last MacFont# to be associated with the 
Winfontname will be used when converting from RTF to Word for the Macintosh 4.0 document.

For example, if the following entries appear in the font-mapping file being used in the conversion from Word for 
Windows to Word for the Macintosh:

Arial;2
Arial;3

then all characters in the Arial font will be given font number 3.

If a Word for Windows font isn't specified in the font-mapping file, then font number 2 (New York) will be used in 
the Word for the Macintosh document.

MacFont#

The MacFont# is the number of the font that will appear in the Word for the Macintosh document in place of the 
associated Winfontname when converting from Word for Windows to a Word for the Macintosh 4.0. If a MacFont# 
has more than one associated Winfontname, the last Winfontname to be associated with the MacFont# will be used 
when converting from Word for Windows to Word for the Macintosh 4.0 document.

For example, if the following entries appear in the font-mapping file being used in the conversion from Word for 
Windows to Word for the Macintosh:

Arial;3
Arial-Narrow;3

then all characters in the Arial or Arial-Narrow font will be given font number 3.



To modify conversion options

The EditConversionOptions macro is stored in the CONVERT.DOT template, which is located in the MACROS 
subdirectory of the Word program directory. If you want to make the EditConversionOptions macro readily 
accessible, you can load this template as a global template.

To run the EditConversionOptions macro

1. Open the CONVERT.DOT template.

2. From the Tools menu, choose Macro. 

3. Select EditConversionsOptions in the Macro Name list.

4. Choose the Run button.

5. Follow the instructions on the screen.



WINWORD6.INI Options

The following sections and their corresponding settings in the WINWORD6.INI file in the Windows directory 
control the defaults and behavior of Word 6.0.

[Microsoft Word]

Setting Description

ASKFORPRINTERPICTURE=<1,0> Controls how Microsoft Excel DDE results 
display:
0 Color

1 Black and white

BitmapMemory=xxxx Sets the maximum size of bitmap caching 
used for graphics. Increase for better 
graphics performance. Default cache size is 
1024K.

CACHESIZE=xxx Sets the maximum size of caching used for 
Word documents. Increase for better 
performance. Minimum cache size is 64K, 
which is also the default.

DDETIMEOUT=xxx Sets the amount of time Word waits for DDE 
messages from another application, 
measured in seconds. Default is 60.

PICEDITCLASS=<classname> Specifies the object class name for an 
alternative drawing server. The default is 
"Word.Picture.6".

DATEFORMAT=<datetemplate> Sets the default date format for the DATE 
field. For example, "dddd, MMMM d, yyyy" 
sets the default to a result such as "Tuesday, 
September 7, 1993."

DISPLAY=<0-3> Sets special screen redraw behavior, in case 
of screen redraw problems with a particular 
screen driver.
0 (zero)        Overrides autodetection of appropriate 

redraw behavior for some screen drivers. Word 
automatically adopts special redraw behavior for 
some screen drivers. This setting overrides that 
behavior. Not normally needed.

1 Eliminates line redraw problems that occur with 
some screen drivers. Use only if "snow" is 
displayed while typing.

2 Eliminates screen redraw problems that occur 
with some screen drivers. Use only if screen 
"remnants" appear when line spacing is other than 
single-spaced or the style area is displayed.

3 Combines options 1 and 2.

TIMEFORMAT=<timetemplate> Sets the default time format for the TIME 
field. For example, "HH:mm" sets the 
default to a result such as "15:50."

NovellNet=<yes/no> Sets special networking code in Word to 
enable Novell networking.

MessageBeeps=<yes/no> Turns on the beep for message boxes. The 
default is Yes.

TrackFaceColor=<yes/no> Tracks the face color of buttons from the 



Windows settings.

SlowShading=<yes/no> Makes Word use a slower algorithm to do 
shading, creating better results. Included for 
compatibility reasons.

NoOwnerFiles=<yes/no> By default, Word creates small owner files 
to know who is currently using a file to 
avoid two instances accessing the same file. 
If this setting is off, Word doesn't create 
these files.

NetworkButtons=<yes/no> Specifies whether to hide or show the 
Network button in dialog boxes such as 
Open, Save As, and Open Data Source.

UpdateDictionaryNumber=<num> Specifies the custom dictionary for the 
spelling checker to add words to; the number 
corresponds to the order of the custom 
dictionary in the list in the Custom 
Dictionaries dialog box.

WPHelp=<1,0> Specifies whether to use WordPerfect key 
combinations:
0 (zero)        Do not use WordPerfect keys

1 Use WordPerfect keys

DOC-EXTENSION=.DOC The default extension added to Word 
document filenames.

DOT-EXTENSION=.DOT The default extension added to Word 
template filenames.

BAK-EXTENSION=.BAK The default extension added to Word backup 
document filenames.

USER-DOT-PATH=<path> The default directory where user templates 
are located. The default is C:
\WINWORD\TEMPLATES

WORKGROUP-DOT-PATH=<path> The default directory where workgroup 
templates are located.

INI-PATH=<path> The default directory where the user options 
stored in .INI files are located. The default is 
C:\WINWORD

DOC-PATH=<path> The default directory in which Word first 
proposes to store documents. The default is 
C:\WINWORD

TOOLS-PATH=<path> The default directory where Word tools, 
such as dictionaries, are located. The default 
is C:\WINWORD

PICTURE-PATH=<path> The default directory where the clipart 
pictures supplied with Word are located. The 
default is C:\WINWORD\CLIPART

AUTOSAVE-PATH=<path> The default directory where the temporary 
files Word automatically saves are located. 
The default is C:\WINWORD.

CBT-PATH=<path> The default directory where Word examples 
and practices are located. The default is C:
\WINWORD\WORDCBT



STARTUP-PATH=<path> Specifies the startup directory used by Word. 
The default is C:\WINWORD\STARTUP

Note that the following proofing settings in the [Microsoft Word] section of WINWORD6.INI take precedence 
over any others in other .INI files.

Spelling <lang#>[,<proof#>]=<path to 
dll>,<path to dict>

Names the DLL and dictionary for a given 
language and spelling dictionary. The default 
is the following: 

Spelling 1033,0=C:
\WINDOWS\MSAPPS\PROOF\MSSPEL2.
DLL, C:
\WINDOWS\MSAPPS\PROOF\MSSP2_EN
.LEX

Grammar <lang#>[,<proof#>]=<path 
to dll>,<path to dict>

Names the DLL and dictionary for a given 
language and grammar checker. The default 
is the following:

Grammar 2057,0=C:
\WINWORD\GRAM.DLL, C:
\WINWORD\GR_AM.LEX

Thesaurus <lang#>[,<proof#>]=<path 
to dll>,<path to database>

Names the DLL and dictionary for a given 
language and thesaurus dictionary. The 
default is the following:

Thesaurus 1033,0=C:
\WINDOWS\MSAPPS\PROOF\MSTHES.
DLL, C:
\WINDOWS\MSAPPS\PROOF\MSTH_AM
.LEX

Hyphenate <lang#>[,<proof#>]=<path 
to dll>,<path to database>

Names the DLL and dictionary for a given 
language and hyphenation dictionary. The 
default is the following:

Hyphenate 1031,0=C:
\WINWORD\HYPH.DLL, C:
\WINWORD\HY_GE.LEX

[MSWord Text Converters]

Setting Description

<convtype>=<description>,<path>,
[ ext]* [,<options>]

Specifies the location of text converters used 
to convert documents from other file 
formats. Here are some examples:

DOS Text with Layout=DOS Text with 
Layout, C:\WINWORD\TXTWLYT.CNV, 
asc

Text with Layout=Text with Layout, C:
\WINWORD\TXTWLYT.CNV, ans

Lotus123=Lotus 1-2-3, C:
\WINWORD\LOTUS123.CNV, wk1 wk3

MSPub=Windows Publisher, C:
\WINDOWS\MSAPPS\TEXTCONV\MSWI



NPUB.CNV,    pub

MSWordWin1=Word for Windows 1.1x, C:
\WINDOWS\MSAPPS\TEXTCONV\WOR
DWIN1.CNV,    doc

MSWorksDos=MS Works, C:
\WINDOWS\MSAPPS\TEXTCONV\WRK
SDOS.CNV,    wps

MS-DOS Text with Layout=MS-DOS Text 
with Layout, C:
\WINWORD\TXTWLYT.CNV, asc

[Table of Authorities Categories]

Setting Description

Category <1-16>=<category> Defines the 16 categories for the Table of 
Authorities.    The defaults are the following:

Category 1=Cases
Category 2=Statutes
Category 3=Other Authorities
Category 4=Rules
Category 5=Treatises
Category 6=Regulations
Category 7=Constitutional Provisions
Category 8=8
...
Category 16=16

[Index]

Setting Description

WW2CrossReference=<0,1> Sets the behavior of the Cross-reference 
command.
0 (zero)        Use Word 6.0 behavior (default)

1 Use Word 2.0 behavior (placing cross-reference 
entries wherever they fall)

 SortLetterByLetter=<0,1> Sets the behaviour of the Index and Tables 
command.
0 (zero)        Sort compiled index word by word

1 Sort compiled index letter by letter

[<printer>]

Setting Description

EnvFeed=<num> Specifies which method to use for feeding 
envelopes.

EnvBin=<num> Specifies which bin to use for feeding 
envelopes.

[MSWord Editable Sections]



<names> Specifies a non-default settings-file section 
to add to the Categories list in the Advanced 
Settings dialog box (ToolsAdvancedSettings 
macro).

[Help]

Setting Description

WPHELP.HLP=<path><filename> The location and filename of the help for 
WordPerfect users upgrading to Word. The 
default is C:\WINWORD\WPHELP.HLP.

WINWORD.HLP=<path><filename> The location and filename of the Word Help 
file. The default is C:
\WINWORD\WINWORD.HLP.

WRDBASIC.HLP=<path><filename> The location and filename of the WordBasic 
Help file. The default is C:
\WINWORD\WRDBASIC.HLP.

WORDPSS.HLP=<path><filename> The location and filename of the PSS Help 
file. The default is C:\WINWORD.

WDREADME.HLP=<path><filename
>

The location and filename of the Readme 
Help file. The default is C:
\WINWORD\WDREADME.HLP.



Supplied Macros

The following templates (installed in the MACROS subdirectory of the Word program directory) contain macros 
that you may find useful in your daily work. If you find one or more of these macros useful, you can load the 
template as a global template and then assign the macro to a toolbar, menu, or shortcut key.

MACRO60.DOT

TABLES.DOT

LAYOUT.DOT

CONVERT.DOT

PRESENT.DOT

Note: If you install Microsoft Office, PRESENT.DOT is installed in the STARTUP subdirectory of the Word 
program directory. PRESENT.DOT contains a macro that turns your Word document into a Microsoft PowerPoint 
presentation.

For more information on loading a template as a global template, see Document Templates in the Word Help file. 
To assign a macro to a toolbar, menu, or shortcut key, see Recording and Running Macros in the Word Help file.



MACRO60.DOT

The MACRO60.DOT template contains useful macros you can use in your general work.

Macro Explanation

DisableAutoBackup Disables the Enable/Disable 
Auto Backup command on the 
File menu (added by the 
EnableAutoBackup macro) and 
removes the FileSave and 
FileSaveAs macros. 

EnableAutoBackup Adds the Enable/Disable Auto 
Backup command to the File 
menu. It also creates FileSave 
and FileSaveAs macros that 
create backups when you save 
files. The macro prompts you 
for a location to save the 
backups.

ExitAll Closes all open document, 
template, and macro-editing 
windows. A dialog box lists all 
open documents and asks if 
you want to save them.

 FindSymbol Finds and replaces symbols 
inserted with the Symbol 
command (Insert menu). In the 
Find And Replace Symbols 
dialog box, choose the Find 
What button to select the 
symbol to search for; choose 
the Replace With button to 
select the symbol to replace it 
with.

FontSampleGenerator Generates a sample document 
that you can print out to show 
all printable fonts on your 
system in the point size you 
specify.

MindBender Demonstrates through a sample 
game several methods for using 
dynamic dialog boxes.

OrganizationalChartMaker Builds an organizational chart 
using the drawing tools in 
Word. Set up the hierarchy 
using built-in heading styles 
(do not include any tab 
characters) and run the macro.

PrintSel2File Saves selected text in an MS-
DOS text file. Select the text 
and run the macro. You can 
append to or overwrite an 
existing file or create a new 
one.



RunWizard Displays a dialog box of 
available Wizards that you can 
run.

SuperDocStatistics Displays a dialog box with a 
comprehensive list of the open 
document's statistics. For 
example, all fonts used in the 
document are listed.



TABLES.DOT

The TABLES.DOT template contains useful macros you can use in working with tables.

Macro Explanation

AccessExporter Converts a selected Word table 
into an Access table.

TableFillDown Fills cells in the selected table 
column with the top-most value 
of each column. Select the 
columns you want to fill and 
run the macro.

TableFillRig
ht

Fills cells in 
the selected 
table row 
with the 
left-most 
value of 
each row. 
Select the 
rows you 
want to fill 
and run the 
macro.

TableMath Helps you 
insert = 
(Formula) 
fields into a 
table by 
selecting 
cell 
references 
and 
calculation 
types such 
as sum, 
average, and 
count. 
Position the 
insertion 
point in the 
table and 
run the 
macro.

TableNumber Adds numbering to rows or 
columns. If necessary, a row or 
column is added to contain the 
numbering. Position the 
insertion point in the table, start 
the macro, and select the 
numbering option you want 
from the dialog box.



LAYOUT.DOT

The LAYOUT.DOT template contains useful macros you can use in manipulating text and page layouts.

Macro Explanation

ArrangeWindows Displays a dialog box where 
you can choose to arrange all 
open windows tiled, 
horizontally, vertically, or 
cascaded.

BaseShiftDown Lowers selected text by one 
point. To lower the text further, 
run the macro again.

BaseShiftUp Raises selected text by one half 
point. To raise the text further, 
run the macro again.

Cascade Rearranges all open windows 
so they overlap in a cascade.

CharacterTrackIn Condenses the spacing of a 
selection by fractions of the 
font size. To condense the text 
further, run the macro again.

CharacterTrackOut Expands the spacing of a 
selection by fractions of the 
font size. To condense the text 
further, run the macro again.

DecreaseFont Reduces the font size of a 
selection by one point. To 
reduce the font size further, run 
the macro again.

DecreaseLeftAndRightIndent Decreases the indent for the 
selected paragraphs an equal 
amount towards the left and 
right margins using the default 
tab settings.

IncreaseFont Increases the font size of a 
selection by one point. To 
increase the font size further, 
run the macro again.

IncreaselLeftAndRightIndent Indents selected paragraphs an 
equal amount from the left and 
right margins using the default 
tab settings.

LineSpaceIn Decreases line spacing for the 
selected paragraph or 
paragraphs.

LineSpaceOut Increases line spacing for the 
selected paragraph or 
paragraphs.

Overscore Adds an overscore to selected 
text by replacing the text with 
an EQ (Equation) field.



PrintableCharacters Creates a document containing 
all printable characters for a 
font. When you run the macro, 
the Font dialog box (Format 
menu) is displayed so you can 
choose the font.

SectionManager Displays all section-level 
formatting in one dialog box. 
You can also modify section 
formatting using the Page 
Setup, Page No's, and Columns 
buttons.

TileHorizontally Tiles all open documents 
horizontally.

TileVertically Tiles all open documents 
vertically.



CONVERT.DOT

The CONVERT.DOT template contains useful macros to simplify conversions and changing conversion options.

Macro Explanation

BatchConversion Runs a Wizard that helps you 
select and convert multiple 
files from another format to 
Word or vise versa.

EditConversionOptions Opens a dialog box that allows 
you to customize file 
conversion settings. The macro 
changes the conversion options 
by changing the settings in the 
mstxtcnv.ini file.



PRESENT.DOT

The PRESENT.DOT template contains the PresentIt macro, which copies the active Word document into a 
Microsoft PowerPoint presentation. You can then edit the document in Microsoft PowerPoint to create slides for a 
presentation.

When PRESENT.DOT is loaded as a global template, Word adds the Present It button to the Microsoft toolbar. If 
you install Microsoft Office, PRESENT.DOT is intalled in the STARTUP subdirectory and Word automatically 
loads it as a global template.

To use the PresentIt macro, you must have Microsoft PowerPoint installed on your computer or on a network 
server to which your computer is connected.




